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Über dieses Tutorium 
In diesem Tutorium führen Sie eine Netzausgleichung für ein Projekt mit GNSS-, 
Nivellement- und Totalstationsdaten durch. 


Hinweise: 


 Eine kombinierte Netzausgleichung für GNSS-, Totalstations- und Nivellierdaten 
kann nur mit der Lizenz Survey Advanced von Trimble Business Center 
durchgeführt werden. Welche Lizenz installiert ist, können Sie unter Hilfe > Über 
Trimble Business Center und dort Lizenz einsehen. Die Liste Funktionen zeigt die 
lizenzierten Funktionen an. 


 Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie einfach 
auf F1, um die Onlinehilfe aufzurufen. 


 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Adjusting the Network.vce. Das 
Projekt enthält bereits GNSS-, Totalstations- und Nivellierdaten; auch die Verarbeitung 
der GNSS-Basislinien ist bereits erfolgt. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Adjusting the Network.vce und klicken Sie auf Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Bevor Sie das Netz ausgleichen können, müssen Sie einige Projekteinstellungen ändern. 


Schritt 2: Ändern der Projekteinstellungen 
In diesem Schritt wählen Sie die Quellen für Vorgabe-Standardabweichungen. 
Anschließend legen Sie die Vorgabe-Standardabweichungen für Totalstations-, Nivellier- 
und GNSS-Daten fest. 


1. Wählen Sie Projekt > Projekteinstellungen. Klicken Sie alternativ auf die 
Schaltfläche Projekteinstellungen  in der Symbolleiste. 
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2. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Netzausgleichung > Allgemein. Wählen Sie anschließend in der Liste 
Mittlerer Winkel die Option Mittel der Messungen verwenden. 


 


3. Wählen Sie im Navigationsbereich Vorgabe-Standardabweichungen .Legen Sie 
dann folgende Optionen fest: 


 Totalstation: 
- Quelle für Standardabweichungen: Importierte Dateien 
- Quelle für Zentrierungsfehler: Projekteinstellungen 


 Nivellement: 
- Quelle für Standardabweichungen: Projekteinstellungen 


 GNSS: 
- Quelle für Standardabweichungen: Basislinienverarbeitungsprogramm 


 Azimut: 
- Quelle für Standardabweichungen: Projekteinstellungen 


4. Wählen Sie im Navigationsbereich Vorgabe-Standardabweichungen > 
Totalstation .Legen Sie dann folgende Optionen fest: 


 Vorgabe-Standardabweichungen: 
- Horizontalwinkel: 0°00'05" 
- Vertikalwinkel: 0°00'05" 


 Vorgabe-Zentrierungsfehler: 
- Gerätezentrierungsfehler: 0,002 m 
- Fehler bei der Zielzentrierung: 0,002 m 


 Vorgabe-Höhenfehler: 
- Fehler in der Instrumentenhöhe: 0,002 m 
- Fehler in der Zielhöhe: 0,002 m 


5. Wählen Sie im Navigationsbereich Vorgabe-Standardabweichungen > 
Nivellement .Legen Sie dann folgende Optionen fest: 


 Vorgabe-Standardabweichungen: 
- Vorgabe-Standardabweichung je 1 km Doppelnivellement: 0,0 mm 
- Vorgabe-Standardabweichung je Standpunktaufstellung: 3,0 mm 


6. Wählen Sie im Navigationsbereich Vorgabe-Standardabweichungen > GNSS 
.Legen Sie dann folgende Optionen fest: 


 Vorgabe-Aufstellungsfehler: 
- Fehler in der Antennenhöhe: ,002 
- Zentrierungsfehler: ,005 
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7. Klicken Sie auf OK, um den Dialog Projekteinstellungen zu schließen. 


Nun können Sie die Netzausgleichung durchführen. Der Vorgang umfasst zwei Schritte. 
Zuerst führen Sie eine minimal bedingte Netzausgleichung durch. Anschließend führen 
Sie eine vollständig bedingte Netzausgleichung durch. 


Schritt 3: Durchführen einer minimal bedingten 
Netzausgleichung 


Mit der minimal bedingten Netzausgleichung können Sie die interne Stimmigkeit des 
Vermessungsnetzes prüfen. Dabei wird die kleinstmögliche Anzahl von Beschränkungen 
zum Definieren des Koordinatensystems verwendet. 


1. Wählen Sie Vermessen > Netz ausgleichen. 


Der Dialog Netz ausgleichen erscheint. 


 


Das Register Festgehaltene Koordinaten führt 13 Festpunkte auf. Davon sind 10 
Höhenfestpunkte aus den DiNi-Nivellementdaten und dem Datenblatt: 


 B412 


 barbara 


 ENERGY 


 F 408 


 flange 


 hard 


 Jeffco AZ MK 


 Jeffco Reset 


 Jeffco Reset 


 sixtwo 


Drei sind Lagefestpunkte aus dem CORS-Datenblatt (Continuously Operating 
Reference Stations): 


 P041 


 PLTC 
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 TMGO 


In diesem Projekt führen Sie eine minimal bedingte Ausgleichung durch, in der die 
Station P041 in Lage und Höhe festgehalten wird. 


2. Markieren Sie auf dem Register Festgehaltene Koordinaten die Kontrollkästchen 
2D und h für den Punkt P041. 


 


3. Klicken Sie auf Ausgleichen. 


Sie werden gefragt, ob Sie die Projektberechnungsfehler lösen möchten. Klicken Sie 
auf Ja, um die Netzausgleichung ohne Lösen der Fehler fortzusetzen. 


Eine Ergebniszusammenfassung der Ausgleichung wird auf dem Register 
Ergebnisse im Fenster Netz ausgleichen angezeigt. 


 


Der Referenzfaktor beträgt 1,35, die Anzahl der Freiheitsgrade beträgt 268 und der 
Chi-Quadrat-Test ist fehlgeschlagen. Vermutlich wurden einige Vektoren in der 
Ausgleichung als Ausreißer markiert oder Sie müssen eine Gewichtungsstrategie auf 
die verarbeiteten Vektoren anwenden. 


4. Klicken Sie im Dialog Netz ausgleichen auf das Symbol Bericht . 


Der Netzausgleichungsbericht wird im Internetbrowser angezeigt. Über die 
Verknüpfungen im Navigationsfenster auf der linken Seite des Berichts können Sie 
diverse Abschnitte anspringen. Sie können aber auch mit der Maus blättern. 


5. Prüfen Sie den Bericht und achten Sie vor allem auf die Abschnitte unter 
„Beobachtungen“: 
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Beobachtungen mit einem standardisierten Restwert (Residuum), die das Tau-
Kriterium nicht bestehen, werden rot angezeigt. Bei diesen Beobachtungen handelt 
es sich um Ausreißer. In diesem Fall sind die verarbeiteten Vektoren TMGO --> 
PLTC (PV135) und filter --> 5 (PV22) im Abschnitt „Ausgeglichene GPS-
Beobachtungen“ als Ausreißer markiert (roter Text).  


 


Hinweis: Jede Beobachtung wird automatisch nummeriert (in Klammern). Die 
Nummern in Ihrem Bericht können von dieser Abbildung abweichen. 


Da das Netz eine hohe Redundanz aufweist, können Sie TMGO --> PLTC (PV135) 
und filter --> 5 (PV22) deaktivieren und anschließend das Netz erneut ausgleichen. 


6. Klicken Sie im Netzausgleichungsbericht im Abschnitt „Ausgeglichene GPS-
Beobachtungen“ auf die Verknüpfung TMGO --> PLTC (PV135). 


Damit wird der Vektor im Projekt markiert. 


7. Klicken Sie im Fenster von Trimble Business Center mit der rechten Maustaste in 
die Planansicht und wählen Sie Eigenschaften. 


Das Fenster Eigenschaften für TMGO --> PLTC (PV135) erscheint. 


 


Hinweis: Wenn Sie irgendwo in das Fenster klicken, bevor Sie das Kontextmenü der 
Planansicht per Rechtsklick aufrufen, ist der Vektor nicht mehr gewählt. 
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8. Wählen Sie in der Liste Status den Eintrag Deaktiviert. 


Die Meldung Ausgleichung löschen erscheint; Sie müssen entscheiden, ob Sie die 
Ergebnisse der vorherigen Netzausgleichung behalten oder verwerfen möchten.  


9. Klicken Sie im Dialog Ausgleichung löschen auf Ausgleichung löschen. 


10. Wiederholen Sie die Schritte 6 bis 8 für Vektor filter --> 5 (PV22).  


Nachdem TMGO --> PLTC (PV135) und filter --> 5 (PV22) deaktiviert sind, können 
Sie die Netzausgleichung wiederholen. 


11. Wählen Sie Vermessen > Netz ausgleichen. Klicken Sie dann auf Ausgleichen, 
um die minimal bedingte Netzausgleichung zu wiederholen. 


Sie werden gefragt, ob Sie die Projektberechnungsfehler lösen möchten. Klicken Sie 
auf Ja, um die Netzausgleichung ohne Lösen der Fehler fortzusetzen. 


Eine Ergebniszusammenfassung der Ausgleichung wird auf dem Register 
Ergebnisse im Fenster Netz ausgleichen angezeigt. 


 


12. Klicken Sie auf das Symbol Bericht , um den Netzausgleichungsbericht zu 
betrachten. 


Der Chi-Quadrat-Test ist erneut fehlgeschlagen; Sie müssen also eine 
Gewichtungsstrategie auf die verarbeiteten Vektoren anwenden. Durch das 
Anwenden einer Gewichtungsstrategie werden die anfänglichen A-Priori-Fehler-
Schätzungen der Beobachtungen verbessert. A-Priori-Fehler sind geschätzte Fehler 
für Beobachtungen, bevor die Netzausgleichung durchgeführt wird. 


13. Klicken Sie im Dialog Netz ausgleichen auf das Register Gewichtung. 
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Im Abschnitt Nachbearbeitete Vektoren wird der Netzreferenzfaktor mit 1,04 
angegeben. Das Ziel ist ein Referenzfaktor von 1,0. 


14. Klicken Sie in den Abschnitten Nachbearbeitete Vektoren, Horizontalwinkel, 


Vertikalwinkel, Schrägstrecken und Nivellement auf , um einen Skalar auf die 
geschätzten Fehler anzuwenden. 


Mit dem Netzreferenzfaktor aus der letzten Ausgleichung wird ein neuer Skalar 
berechnet. Dieser Skalar wird auf die anfänglichen Fehlerschätzungen aller 
nachbearbeiteten Vektoren der Ausgleichung angewandt. 


Nun können Sie die minimal bedingte Netzausgleichung erneut berechnen. 


15. Klicken Sie auf Ausgleichen. 


Sie werden gefragt, ob Sie die Projektberechnungsfehler lösen möchten. Klicken Sie 
auf Ja, um die Netzausgleichung ohne Lösen der Fehler fortzusetzen. 


Im Fenster Netz ausgleichen erscheint das Register Ergebnisse. 


 


Der Netzreferenzfaktor beträgt nun ,97, der Chi-Quadrat-Test ist bestanden. Die 
anfängliche A-Priori-Fehlerschätzung stimmt mit den ausgeglichenen Fehlern der 
Netzvektoren überein.  


Nun können Sie die bedingte Netzausgleichung durchführen. 


Schritt 4: Durchführen einer bedingten 
Netzausgleichung 


In diesem Schritt führen Sie eine bedingte Ausgleichung durch, in der die Koordinaten 
der restlichen Festpunkte unveränderlich bleiben. Das Ziel ist die Berechnung 
ausgeglichener Koordinaten der neu gemessenen Punkte im Netz unter Beibehaltung der 
Nachbarschaftsgenauigkeit zu den bestehenden Festpunkten. 


Die Stationen in dieser Messung sind von unterschiedlicher Vermessungsqualität, 
nämlich: 


 CORS-Qualität (Continuously Operating Reference Stations) 


 Verschiedene Qualitäten nationaler Netzreferenzstationen 


 Ausgeglichene Qualität aus DINI-Beobachtungen  
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Sie können jedem Festpunkt Standardabweichung auf Basis seiner Qualität zuweisen, 
indem Sie zuvor ausgeglichene Werte aus früheren Vermessungen oder 
Fehlerschätzungen aus CORS- oder Landesnetzausgleichungen für Referenzstationen 
verwenden. Wenn Sie einem Festpunkt eine Standardabweichung zuweisen, 
ermöglichen Sie in der Netzausgleichung eine Änderung der Koordinaten dieses 
Festpunkts auf Basis der Beobachtungsqualität und der Qualität der anderen Festpunkte. 


Wenn Sie keine Standardabweichungen festlegen, wird ein fester Wert von 0,000001 m 
(= 1 Mikrometer) für jeden Punkt ungeachtet seiner Qualität verwendet. 


In diesem Tutorium geben Sie feste Werte für die CORS-Stationen, 
Genauigkeitsschätzungen für die NGS-Datenblätter (National Geodetic Survey) und 
einige angenommene Werte für die Festpunkte niedriger Ordnung ein. 


1. Klicken Sie im Dialog Netz ausgleichen auf das Register Festgehaltene 
Koordinaten. Klicken Sie dann auf die Schaltfläche Zugewiesene Gewichtung 
verwenden  oben im Fenster. 


Das Register Festgehaltene Koordinaten wird durch das Register Beschränkte 
Koordinaten ersetzt. 


 


Sie können nun jeden Festpunkt erweitern, um die Standardabweichungen 
einzugeben. In diesem Tutorium verwenden Sie die Hoch- und Rechtswerte der 
Schätzungen. (Wenn verfügbar, können Sie die Lagewerte eingeben.) Allerdings 
müssen Sie zunächst einige Projekteinstellungen ändern. 


2. Verfahren Sie unter Projekt > Projekteinstellungen wie folgt:  


a. Wählen Sie Einheiten > Koordinate und dann in der Liste Lage-
Standardabweichungen erweitern den Eintrag Ja. 


 


b. Wählen Sie Einheiten > Strecke und dann in der Liste Nachkommastellen den 
Eintrag 0,1234. 
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c. Klicken Sie auf OK, um den Dialog Projekteinstellungen zu schließen. 


3. Verfahren Sie auf dem Register Beschränkte Koordinaten im Fenster Netz 
ausgleichen wie folgt: 


a. Klicken Sie auf das Pluszeichen, um B412  zu erweitern.Geben Sie in das Feld 
Höhe den Wert 0,0100 m ein. 


b. Erweitern Sie barbara und geben Sie folgende Werte ein: 
0,0074 m im Feld Norden 
0,0057 m im Feld Osten 
0,0294 m im Feld Höhe 


 


Normalerweise würden Sie auch die Fehlerschätzungen der anderen Punkte 
eingeben. In diesem Tutorium haben wir das bereits für Sie erledigt. 


Fehlerschätzungen für einen Punkt werden nur in der Ausgleichung verwendet, wenn 
Sie mindestens eines der Kontrollkästchen „Fest“ für den Punkt wählen, um ihn als 
Beschränkungspunkt zu definieren. 


In der Praxis werden Sie sich der optimalen bedingten Ausgleichung schrittweise 
nähern und die Festpunkte einzeln nacheinander hinzufügen. In diesem Tutorium 
fassen wir die bedingte Ausgleichung in zwei Schritten zusammen. Zuerst 
beschränken Sie die örtlichen geodätischen NAD83-Koordinaten für die drei 
Lagefestpunkte. Anschließend fügen Sie die Höhenbeschränkung für die Trimble-
DiNi-Festpunkthöhe hinzu. 


Beachten Sie die folgenden Punkte: 


 Örtliche Werte (2D und h) beziehen sich auf örtliche geodätische NAD83-
Koordinaten (Breitengrad, Längengrad und Ellipsoidhöhe), die von Datenblättern 
importiert wurden. 


 Gitterwerte (e) beziehen sich auf NAVD88-Höhen, die von Datenblättern 
importiert oder in Digitalnivellierdateien ausgeglichen wurden. 


In diesem Tutorium beschränken Sie Punkte anhand der örtlichen geodätischen 
Koordinaten. Später fügen Sie Höhenbeschränkungen hinzu. 


4. Klappen Sie die erweiterten Punktknoten zu und wählen Sie die Beschränkungen für 
die Ausgleichung über die Kontrollkästchen 2D und h der folgenden Punkte: 


 hard 


 P041 (sollte bereits aktiviert sein) 


 PLTC  
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 TMGO 


 


5. Klicken Sie auf Ausgleichen. 


Sie werden gefragt, ob Sie die Projektberechnungsfehler lösen möchten. Klicken Sie 
auf Ja, um die Netzausgleichung ohne Lösen der Fehler fortzusetzen. 


Das Register Ergebnisse erscheint. 


 


Normalerweise würden Sie den Netzausgleichungsbericht jetzt genauer prüfen. 
Anhand der Prüfung entscheiden Sie dann, ob weitere Lagefestpunkte gewählt 
werden sollten. In diesem Tutorium fahren Sie ohne weitere Lagefestpunkte fort. 


Nun beschränken Sie lediglich die Lagekoordinaten der drei Lagefestpunkte. Sie 
fügen außerdem die Höhenmarkenhöhen als vertikale Beschränkungen hinzu. Auf 
diese Weise ist das Netz in der Lage an den örtlichen geodätischen NAD83-
Koordinaten und in der Höhe an den NAVD88-Höhenmarkenhöhen aus dem DiNi-
Nivellement beschränkt. 


6. Deaktivieren Sie auf dem Register Beschränkte Koordinaten das Kontrollkästchen 
h für die vier örtlichen Punkte: 


 hard 


 P041 


 PLTC 


 TMGO 


Damit ist die zuvor spezifizierte Beschränkung der Ellipsoidhöhen aufgehoben. 


7. Aktivieren Sie das Kontrollkästchen e für die Gitterpunkte: 


 B 412 
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 F 408 


 sixtwo 


Dadurch wird die Höhenmarkenhöhe für die Ausgleichung hinzugefügt. 


8. Klicken Sie auf Ausgleichen. 


Sie werden gefragt, ob Sie die Projektberechnungsfehler lösen möchten. Klicken Sie 
auf Ja, um die Netzausgleichung ohne Lösen der Fehler fortzusetzen. 


Das Register Ergebnisse erscheint. 


 


9. Klicken Sie in der Symbolleiste von Trimble Business Center auf das Symbol 
Vergrößern , um die hier gezeigte Ansicht zu erreichen. Klicken Sie alternativ in 
die Planansicht und zoomen Sie mit dem Mausrad. Drücken Sie das Mausrad und 
bewegen Sie die Maus, um die Punkte in die Anzeigenmitte zu holen. 


 


Die Fehlerellipsen werden rot dargestellt. 


10. Klicken Sie im Dialog Netz ausgleichen auf das Symbol Bericht  und prüfen Sie 
den Abschnitt „Ausgeglichene Gitterkoordinaten“. 


Dieser Abschnitt zeigt, welche Koordinaten in der Ausgleichung festgehalten wurden. 
Alle Koordinaten mit Ausnahme der Festpunkte weisen Schätzfehler auf. 
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Das Register Ergebnisse im Fenster Netz ausgleichen zeigt Fehler und Restklaffen 
für mindestens ein markiertes Objekt (Punkt, Beobachtung, nachbearbeiteter Vektor) 
an. Markieren Sie die zu betrachtenden Objekte in der Planansicht, indem Sie einen 
Auswahlrahmen ziehen. Die Auswahl wird im Register Ergebnisse angezeigt. 


 


Sie haben das Netz ausgeglichen. Nun importieren Sie zusätzliche Daten in das 
ausgeglichene Projekt. 


Schritt 5: Importieren zusätzlicher Daten in ein 
ausgeglichenes Projekt 


Falls die zu importierenden zusätzlichen Projektdaten dieselben Punktnamen wie im 
ausgeglichenen Projekt verwenden, können Sie bestimmen, dass die neuen Koordinaten 
den ausgeglichenen Koordinaten entsprechen sollen. In diesem Fall importieren Sie eine 
neue Datendatei, die einen Polygonzug von Punkt 5 zu Punkt frey enthält – beide Punkte 
sind im ausgeglichenen Projekt enthalten. 


1. Wählen Sie Datei > Importieren .Klicken Sie alternativ auf die Schaltfläche 
Importieren  in der Symbolleiste. 
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Das Fenster Importieren wird rechts im Fenster von Trimble Business Center 
angezeigt. 


 


2. Klicken Sie im Fenster Importieren auf die Schaltfläche Durchsuchen . 


3. Markieren Sie im Dialog Ordner suchen den Ordner C:\Trimble 
Tutorials\TBC\Data\Adjusting the Network und klicken Sie auf OK. 


4. Markieren Sie in der Liste Datei(en) auswählen die Datei 53frey.jxl und klicken Sie 
auf Importieren. 


Da die Software einen Unterschied zwischen dem Koordinatensystem des Projekts 
und dem Koordinatensystem der Importdatei erkennt, erscheint der Dialog 
Projektkoordinatensystem. 


5. Aktivieren Sie die Option Vorhandene Projektdefinition verwenden im Dialog 
Projektkoordinatensystem. Klicken Sie dann auf OK. 


Die Meldung Ausgleichung löschen erscheint; Sie müssen entscheiden, ob Sie die 
Ergebnisse der Netzausgleichung behalten oder verwerfen möchten. In diesem 
Tutorium behalten Sie die Ausgleichung nach dem Importieren der neuen Daten. 


6. Klicken Sie im Dialog Ausgleichung löschen auf Ausgleichung beibehalten. 


Die neuen Daten werden importiert; dabei werden für die Punkte 5 und frey die in der 
Netzausgleichung berechneten Koordinaten verwendet. 
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Sie können in der Symbolleiste von Trimble Business Center auf die Schaltfläche 
Vergrößern klicken oder das Mausrad verwenden, um die Ansicht zu vergrößern und 
den hier angezeigten Polygonzug zu betrachten. 


 


7. Wählen Sie Ansicht > Projekt-Explorer. Klicken Sie dann im Projekt-Explorer mit 
der rechten Maustaste auf Punkte > frey und wählen Sie den Eintrag Punkt-
Ableitungsbericht. 


Der Punkt-Ableitungsbericht wird im Internetbrowser angezeigt. 


Der Bericht zeigt den Wert für Punkt frey. In diesem Fall ist es der Wert aus der 
Netzausgleichung. Sie können auch den Koordinatenwert aus der importierten Datei 
53frey.jxl einsehen. 


Sie haben das Netz ausgeglichen. 


8. Wählen Sie im Fenster Trimble Business Center den Eintrag Datei > Projekt 
schließen. 


Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 
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Über dieses Tutorium 
In diesem Tutorium importieren Sie zwei mit einem Trimble-DiNi-Nivellier erfasste 
Datendateien in ein Projekt, das bereits GNSS-Daten enthält. 


Hinweis: Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie 
einfach auf F1, um die Onlinehilfe aufzurufen. 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Importing Digital Level Data.vce. Das 
Projekt enthält bereits GNSS-Daten; auch die Verarbeitung der GNSS-Basislinien ist 
bereits erfolgt. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Importing Digital Level Data.vce und klicken Sie auf 
Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Vor dem Importieren der Digitalnivellierdaten legen Sie die Vorgabe-
Standardabweichungen für die Daten fest. 


Hinweis: Sie können die Vorgabe-Standardabweichungen eines Projekts jederzeit 
ändern. Um die Änderungen zu übernehmen, müssen Sie jedoch den Editor für 
Nivellements wie in diesem Tutorium beschrieben öffnen und schließen. 







 Schritt 2: Festlegen von Vorgabe-Standardabweichungen  


Tutorium zu Trimble Business Center – Importieren von Digitalnivellierdaten 5 


Schritt 2: Festlegen von Vorgabe-
Standardabweichungen 


In diesem Schritt legen Sie die Vorgabe-Standardabweichungen für das Projekt fest und 
prüfen, ob der richtige Vorgabewert zum Berechnen der Standardabweichung für 
Beobachtungen im Editor für Nivellements gewählt ist. 


1. Wählen Sie Projekt > Projekteinstellungen. Klicken Sie alternativ auf die 
Schaltfläche Projekteinstellungen  in der Symbolleiste. 


2. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Vorgabe-Standardabweichungen. 


3. Wählen Sie im Bereich Nivellement in der Liste Quelle für Standardabweichungen 
den Eintrag Projekteinstellungen. 


 


So stellen Sie sicher, dass die in den Projekteinstellungen spezifizierte 
Standardabweichung (siehe die nächsten beiden Schritte) zum Berechnen der 
Standardabweichung für Beobachtungen im Editor für Nivellements verwendet 
wird. 


Hinweis: Alternativ können Sie eine Standardabweichung aus der Datendatei 
übernehmen, die während des Importierens in einem Feld im Editor für 
Nivellements angezeigt wird (und dort auch geändert werden kann). Das ist dann 
hilfreich, wenn Sie Nivellementdaten von verschiedenen Digitalnivellieren 
unterschiedlicher Genauigkeitsklassen importieren und die jeweilige 
Standardabweichung während des Importvorgangs ändern möchten. In diesem 
Tutorium verwenden Sie jedoch die Werte aus den Projekteinstellungen. 


4. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Vorgabe-Standardabweichungen > Nivellement. 


5. Geben Sie ins Feld Vorgabe-Standardabweichung je 1 km Doppelnivellement 
den Wert 0,7 mm ein. 
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Stellen Sie sicher, dass die Vorgabe-Standardabweichung je 
Standpunktaufstellung den Wert 0,0 mm enthält. Wenn in beiden Feldern Werte 
angegeben sind, wird als Standardabweichung für Nivellements eine Kombination 
der beiden Werte zum Berechnen der Standardabweichungen für Beobachtungen 
benutzt. 


 


6. Klicken Sie auf OK. 


Sie haben nun die Projekteinstellungen vorgenommen und können die 
Digitalnivellierdaten importieren. 


Schritt 3: Importieren der ersten Digitalnivellement-
Datendatei 


In diesem Tutorium importieren Sie zwei Digitalnivellement-Datendateien. Die erste Datei 
enthält mehrere Nivellementabschnitte. Sie führen Nivellements zusammen, benennen 
Punkte um und wählen Punkte ab und gleichen die Abschnitte vor dem Importieren aus. 
Die zweite Datei enthält nur einen Nivellementabschnitt, den Sie ohne Ausgleichung 
importieren. 


1. Wählen Sie Datei > Importieren .Klicken Sie alternativ auf die Schaltfläche 
Importieren  in der Symbolleiste. 


Das Fenster Importieren wird rechts im Fenster von Trimble Business Center 
angezeigt. 


 


2. Klicken Sie im Fenster Importieren auf die Schaltfläche Durchsuchen . 
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3. Markieren Sie im Dialog Ordner suchen den Ordner C:\Trimble 
Tutorials\TBC\Data\Importing Digital Level Data und klicken Sie auf OK. 


Der Inhalt des Ordners Importing Digital Level Data wird in der Liste Datei(en) 
auswählen im Fenster Importieren angezeigt. 


4. Markieren Sie in der Liste Datei(en) auswählen die Datei B412.DAT und klicken Sie 
auf Importieren. 


Der Dialog Editor für Nivellements erscheint. 


 


In diesem Dialog können Sie die Nivellementdaten vor dem Importieren überprüfen 
und ändern. Die Summe der RB- und VB-Strecken wird angezeigt, sodass Sie prüfen 
können, ob das Streckenverhältnis passt. 


Die importierte Nivellementdatendatei enthält sechs separate Nivellementabschnitte, 
die drei Doppelnivellements entsprechen. Die folgende Abbildung zeigt, wie die 
Einzelnivellements zusammenhängen. 
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Im ersten Schritte führen Sie die Nivellementabschnitte zusammen, damit im Editor für 
Nivellements die Abschlussfehler berechnet werden können. 


Schritt 4: Zusammenführen von 
Nivellementabschnitten 


In der Datei B412.dat ist Punkt B412 der einzige Punkt, für den eine Kontrollhöhe 
eingegeben wurde (siehe Abbildung unten). 


Damit im Editor für Nivellements Abschlussfehler berechnet werden können, muss das 
Nivellement am selben Punkt beginnen und enden. Alternativ müssen Anfangs- und 
Endpunkt eine bekannte Höhe haben. Diese Nivellementabschnitte beginnen oder enden 
jeweils an einer Höhenmarke oder aber an unbekannten Punkten. In keinem dieser Fälle 
werden Abschlussfehler berechnet. 


 


Hinweis: Sie können Nivellementdaten importieren, ohne zuvor Nivellementabschnitte 
zusammenzuführen oder Abschlussfehler zu bestimmen. Dann würden alle Daten so 
kombiniert, wie sie gemessen wurden. Sie können auch eine Ausgleichung nach der 
Methode der kleinsten Quadrate im Editor für Nivellements durchführen, ohne 
Abschnitte zusammenzuführen. Das Kombinieren der Nivellementabschnitte ist allerdings 
eine gute Qualitätsprüfung, bei der Sie Fehler und grobe Patzer entdecken können. 


In diesem Tutorium führen Sie Nivellements im Editor für Nivellements zusammen. 
Damit zwei Nivellementabschnitte zusammengeführt werden können, muss der Endpunkt 
des ersten Abschnitts dem Anfangspunkt des zweiten Abschnitts entsprechen. 


1. Klicken Sie im Dialog Editor für Nivellements unten rechts auf Nivellements 
zusammenführen. 
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Der Dialog Nivellements zusammenführen erscheint. 


 


2. So führen Sie Nivellements zusammen: 


a. Geben Sie im Feld Neuer Abschnittsname den Namen 15 ein. 


b. Wählen Sie in der Liste Beginnen mit Abschnittsname den Wert 1; der 
Endpunkt ist hier flange. 


c. Wählen Sie in der Liste Hinzufügen Abschnittsname den Wert 5; der 
Anfangspunkt ist hier flange. 


d. Klicken Sie auf OK. 


Die Register Abschnitt im Dialog Editor für Nivellements zeigen, wie die 
Abschnitte 1 und 5 zum neuen Abschnitt 15 vereint wurden. 
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Hinweis: Sie können im Editor für Nivellements unten rechts auf Zurücksetzen 
klicken, um Änderungen, die Sie während dieser Sitzung an der Datei durchgeführt 
haben, zurückzunehmen. Sobald Sie jedoch Änderungen vornehmen und auf OK 
klicken, werden diese (auch Zusammenführungen) gespeichert. Wenn Sie den 
Editor für Nivellements für diese Datei nach dem Importieren erneut öffnen, kann 
Zurücksetzen keine Änderungen aus der vorherigen Änderungssitzung 
zurückgängig machen. Wenn Sie in einer Änderungssitzung einen Fehler gemacht 
haben, können Sie die Datei im Bereich Projekt-Explorer > Importierte Dateien 
löschen und erneut importieren. 


3. Wiederholen Sie das Zusammenführen für die folgenden Nivellements:  


a. Führen Sie die Abschnitte 6 und 2 zum neuen Nivellement 62 zusammen. 


b. Führen Sie die Abschnitte 15 und 62 zum neuen Nivellement 1562 zusammen. 


c. Führen Sie die Abschnitte 3 und 4 zum neuen Nivellement 34 zusammen. 


Für jedes zusammengeführte Nivellement wird ein Abschlussfehler angezeigt. Er 
zeigt Ihnen, ob die Anforderungen erfüllt wurden. 


 


 


Schritt 5: Umbenennen und Abwählen von Punkten 
In Nivellement 1562 sind einige Punkte mit einem gelben Punkt neben dem Punktnamen 
zu sehen. Diese Punkte werden auch in anderen Nivellements dieser Datei verwendet. 
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Der Editor für Nivellements durchsucht die Datei nach Punkten, die automatisch von 
einem Trimble-DiNi-Nivelliergerät benannt wurden, und nach Punkten, die vom 
Vermessungspersonal benannt wurden. Darum werden einige Punkte in Trimble 
Business Center erzeugt, andere dagegen nicht. 


 


Wenn ein solcher vom DiNi benannter Punkt oder ein Punkt, der das DiNi-
Benennungsschema verwendet, tatsächlich erzeugt werden soll, können Sie das 
Kästchen neben dem Punktnamen aktivieren, um den Punkt im Projekt anzulegen. 


In dieser Datei müssen einige Punkte aufgrund der im DiNi möglichen Zeichenzahl 
umbenannt werden. In diesen Fällen müssen die Punktnamen bereits im Projekt 
bestehenden Punkten entsprechen. 


1. Wählen Sie das Register Nivellement 1562 und ändern Sie die Punktnamen der 
folgenden Punkte, indem Sie in das Feld Punktname klicken und den neuen Namen 
eingeben: 


 Ändern Sie jeffcoaz in jeffco az mk. 


Da das Nivellement weitere Messungen zu diesem Punkt enthält, werden Sie 
gefragt, ob alle Messungen umbenannt werden sollen. Wählen Sie Ja. 


 Ändern Sie jeffco r in jeffco reset. 


Da dieser Punkt nur als Anschlusspunkt der nächsten Aufstellung dient, werden 
Sie nicht gefragt, ob alle Messungen umbenannt werden sollen. 


 Ändern Sie A412 res in A 412 reset. 


Nivellement 34 enthält mehrere Punkte, die als „zu erstellen“ markiert sind, die aber 
nicht erstellt werden müssen. Sie können diese Punkte wie im nächsten Schritt 
beschrieben abwählen. 


2. Wählen Sie das Register Nivellement 34 und wählen Sie die folgenden Punkte in der 
Spalte Erstellen ab: 


 HYD1 


 thing 


 HYD2 


 HYD3 


Nun können Sie die Nivellements ausgleichen und importieren. 
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Schritt 6: Ausgleichen von Nivellements und 
Importieren von Daten 


Beachten Sie, dass die Abschlussfehler für Nivellement 1562 und Nivellement 34 
berechnet worden sind. 


 


 


Sie könnten diese Daten mithilfe der Rohhöhen importieren und den Befehl Netz 
ausgleichen in Trimble Business Center verwenden, um Fehler in den Daten 
auszugleichen. In diesem Tutorium verwenden Sie jedoch die per DiNi definierten Punkte 
als Höhenpasspunkte (vertikale Festpunkte) für eine Netzausgleichung. Daher muss die 
Ausgleichung im Editor für Nivellements erfolgen. 


1. Klicken Sie unten rechts im Dialog auf Nivellements ausgleichen. 


Der Dialog Nivellements ausgleichen erscheint. Beide Nivellements sind für die 
Ausgleichung gewählt. 


 


2. Klicken Sie auf OK.  







 Schritt 6: Ausgleichen von Nivellements und Importieren von Daten  


Tutorium zu Trimble Business Center – Importieren von Digitalnivellierdaten 13 


Es wird eine Ausgleichung nach der Methode der kleinsten Quadrate durchgeführt. 
Die Korrekturen und ausgeglichenen Höhen für jeden Punkt werden im Editor für 
Nivellements angezeigt. 


 


Sie können diese ausgeglichenen Höhen verwenden, um eine Netzausgleichung für 
andere Daten im Projekt durchzuführen. 


3. Wählen Sie im unteren Teil des Dialogs Editor für Nivellements im Bereich 
Erstellungsoptionen die Option Weitere Ausgleichung verhindern. 


 


Alle Punkte werden nunmehr mit einer Höhe von Festpunktqualität erzeugt. Nur die 
Höhe der Festpunktqualität wird importiert – die Beobachtungen nicht. Bei der 
Netzausgleichung erscheinen die Punkte in der Liste Festgehaltene Koordinaten 
und können als Festpunkte verwendet werden. 


Wenn Sie die Option Netzausgleichung zulassen gewählt hätten, wäre den 
Punkten Vermessungsqualität zugewiesen worden. Dabei wären auch die 
Beobachtungen der Höhenunterschiede zwischen den Punkten erzeugt worden. 


4. Klicken Sie auf OK, um die ausgeglichenen Nivellementdaten in das Projekt zu 
importieren. 


5. So betrachten Sie die neu importierten Digitalnivellementdaten im Projekt-Explorer:  


a. Wählen Sie Ansicht > Projekt-Explorer. 


b. Klicken Sie im Projekt-Explorer auf das Pluszeichen vor dem Eintrag 
Importierte Dateien. 
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c. Blättern Sie abwärts zum Eintrag B412.DAT und wählen Sie im Kontextmenü 
(Rechtsklick) des Dateinamens den Eintrag Erweitern. 


 


Sie können nun die zweite Digitalnivellement-Datendatei in das Projekt importieren. 


Schritt 7: Importieren der zweiten Digitalnivellement-
Datendatei 


In diesem Schritt importieren Sie eine Nivellierdatendatei mit nur einem 
Nivellementabschnitt. Es handelt sich um eine Schleife, die in Punkt sixtwo beginnt und 
endet. Als Starthöhe wurde der Wert 100,000 verwendet. Punkt sixtwo ist einer der 
Festpunkte, die in den Nivellementdaten B412.DAT gemessen wurden. Da die Punkte 
aus dieser Datei als Festpunkte gespeichert wurden, können Sie die entsprechenden 
Höhen auch für diese zweite Datei verwenden. Damit Sie einen Punkt wählen können, 
muss er von Festpunktqualität sein. 


In „Schritt 3: Importieren der ersten Digitalnivellement-Datendatei“ haben Sie Daten über 
den Befehl Importieren eingelesen. In diesem Schritt verwenden Sie ein anderes 
Verfahren zum Importieren: Ziehen und Ablegen. 


1. Klicken Sie in Windows auf Startmenü > Arbeitsplatz und wählen Sie den Ordner 
C:\Trimble Tutorials\TBC\Data\Importing Digital Level Data. 


2. Klicken Sie im Ordner Digital Level Data auf die Datei SIXTWO.DAT und ziehen Sie 
diese Datei bei gedrückter Maustaste in die Planansicht von Trimble Business 
Center. 
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Der Dialog Editor für Nivellements erscheint. 


 


3. Wählen Sie im Feld Höhentyp für Punkt sixtwo den Eintrag Koordinate und klicken 
Sie neben das Feld. 


Der Editor für Nivellements liest die Höhe von Punkt sixtwo aus dem Projekt und 
trägt sie ins Feld Ausgeglichene Höhe ein. 


 


Diese Schleife enthält mehrere Punkte aus dem Projekt: sixtwo, hanna und filter. Das 
Nivellement enthält jedoch auch Punkte, die nicht benötigt werden. 


4. Wählen Sie in der Spalte Erstellen alle Punkte bis auf sixtwo, hanna und filter ab. 


Da es sich um ein Schleifennivellement handelt, wurde im Editor für Nivellements 
ein Abschlussfehler von 0,00550 m berechnet. 


 


Sie könnten dieses Nivellement ebenso wie die Datei B412.DAT ausgleichen. 
Stattdessen importieren Sie die Daten ohne Ausgleichung. Die Daten werden später 
im Rahmen einer Netzausgleichung korrigiert. 


5. Klicken Sie auf OK, um die zweite Datendatei in das Projekt zu importieren. 
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Die neu importierten Digitalnivellementdaten werden im Projekt-Explorer angezeigt. 


 


Sie haben nun sämtliche Digitalnivellier-Daten in das Projekt importiert. 


6. Wählen Sie Datei > Projekt schließen. 


Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 
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Über dieses Tutorium 
In diesem Tutorium importieren Sie Festpunkt- und statische GNSS-Daten in ein neues 
Projekt, führen Punkte zusammen und laden Referenz- und präzise Bahndaten herunter. 
Außerdem importieren Sie eine georeferenzierte Bilddatei in das Projekt. 


Hinweis: Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie 
einfach auf F1, um die Onlinehilfe aufzurufen. 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Importing GNSS Data.vce. Die 
Projekteinstellungen sind bereits festgelegt, aber es wurden noch keine Daten importiert. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Importing GNSS Data.vce und klicken Sie auf Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. Da noch keine 
Daten importiert wurden, ist die Planansicht leer. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Sie können nun GNSS-Festpunktdaten in das Projekt importieren. 


Schritt 2: Importieren von GNSS-Festpunktdaten 
1. Wählen Sie Datei > Importieren .Klicken Sie alternativ auf die Schaltfläche 


Importieren  in der Symbolleiste. 


Das Fenster Importieren wird rechts im Fenster von Trimble Business Center 
angezeigt. 
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2. Klicken Sie im Fenster Importieren auf die Schaltfläche Durchsuchen . 


3. Markieren Sie im Dialog Ordner suchen den Ordner C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data und klicken Sie auf OK. 


Der Ordner Importing GNSS Data enthält die NGS-Datenblatt-Datei, die in diesem 
Projekt verwendet wird. Diese Datei wurde zuvor von der NGS-Website 
http://www.ngs.noaa.gov/cgi-bin/datasheet.prl heruntergeladen. Der Zugriff auf diese 
Site ist über Datei > Internet-Download möglich. 


Der Inhalt des Ordners Importing GNSS Data wird in der Liste Datei(en) auswählen 
im Fenster Importieren angezeigt. 


 


4. Markieren Sie in der Liste Datei(en) auswählen die Datei B 412 ds.txt und klicken 
Sie auf Importieren. 


Die markierte Datei wird ins Projekt importiert; der berechnete Punkt erscheint in der 
Planansicht. 


 



http://www.ngs.noaa.gov/cgi-bin/datasheet.prl
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5. Klicken Sie in der Planansicht auf den Punkt B 412, um ihn zu markieren. Öffnen 
Sie dann mit der rechten Maustaste das Kontextmenü und wählen Sie 
Eigenschaften, um das Fenster Eigenschaften für den markierten Punkt zu öffnen. 


Im Fenster Eigenschaften sehen Sie, dass für die Lage Unbekannter Festpunkt  
eingestellt ist; für die Höhe ist Vermessungsqualität (vom Geoid)  eingestellt; die 
orthometrische Höhe ist als Festpunktqualität  gewählt. 


 


6. Wählen Sie Ansicht > Projekt-Explorer. Klicken Sie alternativ auf die Schaltfläche 
Projekt-Explorer  in der Symbolleiste. 


Der Projekt-Explorer  erscheint. 


7. Wählen Sie im Projekt-Explorer im Kontextmenü (Rechtsklick) den Eintrag Punkte 
und dann Erweitern. Klicken Sie dann mit der rechten Maustaste auf das Symbol 
Importierte Dateien und wählen Sie Erweitern. 
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Sie können nun die neu importierte Datei und den resultierenden Punkt betrachten. 


 


Sie können jetzt statische GNSS-Daten in das Projekt importieren. 


Schritt 3: Importieren von statischen GNSS-Daten 
1. Wählen Sie Datei > Importieren .Klicken Sie alternativ auf die Schaltfläche 


Importieren  in der Symbolleiste. 


Das Fenster Importieren wird rechts im Fenster von Trimble Business Center 
angezeigt. 


2. Klicken Sie im Fenster Importieren auf die Schaltfläche Durchsuchen . 


3. Markieren Sie im Dialog Ordner suchen den Ordner C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data und klicken Sie auf OK. 


Der Ordner Importing GNSS Data enthält eine GPS-Datendatei im ZIP-Format, die in 
der Liste Datei(en) auswählen im Fenster Importieren erscheint. 


4. Markieren Sie die Datei Static Data.zip in der Liste Datei(en) auswählen und klicken 
Sie auf Importieren. 


Der Dialog Empfängerrohdaten einlesen erscheint. 
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Sie können eines der Register unten links im Dialog auswählen und die angezeigten 
Daten prüfen oder ändern. So können Sie Punktnamen oder Objektcodes auf dem 
Register Punkt ändern oder die Antennenhöhe oder das Messverfahren auf dem 
Register Antenne korrigieren. 


Anleitungen zum Bearbeiten von Antennentypen, Messverfahren und Messwerten 
finden Sie im Thema „Eintragen von GNSS-Rohdaten“ in der Onlinehilfe (F1). Klicken 
Sie in Schritt 7 des Hilfethemas auf die Verknüpfung Bearbeiten mehrerer 
Antennenhöhen. 


Die Daten für dieses Tutorium sind allerdings korrekt und müssen nicht geändert 
werden. 


5.  Klicken Sie im Dialog Empfängerrohdaten einlesen auf OK. 


Die Datei mit statischen GNSS-Daten wird ins Projekt importiert und die Daten 
werden in der Planansicht angezeigt. 


 


Sie müssen einige Punkte des Projekts zusammenführen. Wie das geht, beschreibt der 
nächste Abschnitt. 


Schritt 4: Zusammenführen von Punkten 
Die Punkte fsi 16406 a und fsi wurden mehrfach unter verschiedenen Namen importiert. 
Sie müssen diese Punkte daher zusammenführen. 


1. Wählen Sie Punkt > Punktduplikate Punkte zusammenführen. 
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Das Fenster Punkte zusammenführen erscheint. 


 


2. fsi und fsi 16406 a liegen dicht beieinander. Klicken Sie daher auf die Schaltfläche 
Vergrößern  in der Symbolleiste, um den Ausschnitt der Planansicht so zu 
vergrößern, dass beide Punkte sichtbar sind. Sie können auch mit dem Cursor in die 
Planansicht klicken und anschließend mit dem Mausrad zoomen. 


 


3. Klicken Sie im Fenster Punkte zusammenführen in das Feld Daten und markieren 
Sie die Punkte fsi und fsi 16406 a in der Planansicht, indem Sie einen Rahmen 
darum zeichnen. 


fsi und fsi 16406 a werden nun in der Liste Gewählte Punkte aufgeführt. 


4. Prüfen Sie im Bereich Letzter Punkt, dass fsi in der Liste Punkt wählen gewählt ist. 


5. Prüfen Sie im Bereich Gewählte Punkte, dass die Kontrollkästchen fsi 16406 a und 
fsi beide aktiviert sind. 


6. Klicken Sie auf OK. 


7. Klicken Sie im Projekt-Explorer auf das Pluszeichen vor dem Eintrag Punkte, um 
die Punktliste zu erweitern. Sie können sehen, dass die Punkte zusammengeführt 
wurden. 


fsi und fsi 16406 a vor dem Zusammenführen: 
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fsi nach dem Zusammenführen: 


 


Da Sie Punkte zusammengeführt haben, leuchtet der Hinweis Projektberechnung 
erforderlich (unten im Fenster von Trimble Business Center) rot auf, um Sie über 
die erforderliche Neuberechnung zu informieren. 


 


8. Klicken Sie auf den roten Hinweis (Projektberechnung erforderlich) oder drücken 
Sie F4, um das Projekt neu zu berechnen. 


Nun können Sie Daten zu Referenzstationen herunterladen. 


Schritt 5: Herunterladen von Referenzstationsdaten 
In diesem Abschnitt verwenden Sie den Befehl Internet-Download, um 
Referenzstationsdaten einer lokalen CORS-Station herunterzuladen. 


1. Wählen Sie Datei > Internet-Download. Klicken Sie alternativ auf die Schaltfläche 
Internet-Download  in der Symbolleiste. 


Das Fenster Internet-Download erscheint. 


 


2. Klicken Sie auf die Schaltfläche Internet-Downloadkonfiguration  oben im 
Fenster. 


3. Klicken Sie im Dialog Internet-Downloadkonfiguration auf Neue Site. 


Der Dialog Neue Site erscheint. In diesem Projekt treffen Sie die Auswahl in einer 
Anbieterliste auf der Trimble-Website. 
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4. Aktivieren Sie die Option Aus vordefinierter Liste wählen und achten Sie darauf, 
dass das Kontrollkästchen darunter aktiviert ist. Klicken Sie dann auf OK. 


Der Dialog Vordefinierten Referenzstationsanbieter hinzufügen erscheint; er zeigt 
die aktuelle Liste der Referenzstationsanbieter auf der Trimble-Website. Die Anbieter 
sind nach der Entfernung vom Projektzentrum sortiert. 


Sie können auf einen beliebigen Spaltenkopf klicken, um die Sortierung zu ändern. 


 


5. Markieren Sie im Dialog Vordefinierten Referenzstationsanbieter hinzufügen die 
Station CORS, MARSHALL FIELD p041 in der Liste. Klicken Sie dann auf OK. 


Die Siteeigenschaften dieser Referenzstation werden im Dialog Neue 
Siteeigenschaften für Gruppe Referenzstationen angezeigt. Sie müssen keine 
Änderungen vornehmen. 


6. Klicken Sie auf OK. 


Der markierte Anbieter wird im Dialog Internet-Downloadkonfiguration angezeigt. 


 


7. Klicken Sie auf OK. 
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Der markierte Anbieter wird im Fenster Internet-Download angezeigt. 


 


8. Klicken Sie doppelt auf P041 – CORS, MARSHALL FIELD oder markieren Sie die 
Station und klicken Sie unten im Fenster auf Automatisch. 


Der Dialog Download-Parameter erscheint. Falls ein Projekt mehrere Zeitspannen 
umfasst, können Sie diese in der Liste auswählen. Da dieses Projekt nur eine 
Zeitspanne enthält, müssen Sie keine Auswahl treffen. 


9. Klicken Sie auf OK. 


Das neue Register #1 erscheint im Fenster Internet-Download; es enthält die 
Dateien, die heruntergeladen werden sowie die Dateien, die importiert werden 
können. Der Vorgang für jede Datei ist definiert und wird in der Spalte Vorgang 
angezeigt. Sie können einen Vorgang auswählen und ändern. 


 


Hinweis: Die Protokoll- und Infodateien (TXT) können nicht importiert werden. Sie 
können die Dateien jedoch mit den Projektdaten speichern. Ändern Sie dazu den 
Vorgang von Löschen in Speichern. 


10. Klicken Sie auf dem Register #1 auf die Schaltfläche Importieren, um die Zeitspanne 
zu importieren. 


Der Dialog Empfängerrohdaten einlesen erscheint. Üblicherweise prüfen Sie die 
Daten auf allen Registern auf Korrektheit. In diesem Tutorium haben wir das bereits 
erledigt – Sie müssen sich diese Arbeit hier nicht machen. 


11. Klicken Sie auf OK. 







 Schritt 6: Herunterladen von präzisen Bahndaten  


Tutorium zu Trimble Business Center – Importieren von GNSS-Daten 13 


Die neu importierten Referenzstationsdaten werden im Fenster Projekt-Explorer 
und in der Planansicht angezeigt. 


 


Jetzt können Sie präzise Bahndaten in das Projekt herunterladen und anschließend die 
Basislinien verarbeiten. 


Schritt 6: Herunterladen von präzisen Bahndaten 
Um die Basislinien des Projekts zu verarbeiten, können Sie präzise Bahndaten für die 
Zeitspanne der GNSS-Daten herunterladen und importieren. Da die Daten für das Projekt 
in der Vergangenheit gemessen wurden, können Sie die endgültigen Bahndaten zum 
Verarbeiten der Basislinien verwenden.  


1. Klicken Sie im Fenster Internet-Download doppelt auf Finale IGS-Bahndaten. 
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Der Dialog Download-Parameter erscheint. 


 


Falls ein Projekt mehrere Zeitspannen umfasst, können Sie diese in der Liste 
auswählen. Da dieses Projekt nur eine Zeitspanne enthält, müssen Sie keine 
Auswahl treffen. 


2. Klicken Sie auf OK. 


Die herunterzuladenden Daten werden im Register #2 angezeigt. 


 


3. Wiederholen Sie diesen Vorgang im Fenster Internet-Download auf dem Register 
Starten für Finale IGS-Glonass-Bahndaten. 


4. Klicken Sie im Fenster Internet-Download auf den Registern #2 und #3 auf 
Importieren, um die Zeitspannen zu importieren. 


Anschließend importieren Sie ein Bild mit Georeferenzierung in der Bilddatei. Das Bild 
wird in der Planansicht an den globalen Koordinaten aus den Georeferenzdaten 
dargestellt. 


Hinweis: Sie können auch Bilddateien ohne enthaltene Georeferenzdaten importieren, 
wenn eine zugehörige World-Georeferenzdatendatei vorliegt. Die zugehörige Datei muss 
denselben Namen wie das georeferenzierte Bild mit einer anderen Endung tragen (z. B. 
WLD oder INI). 


Schritt 7: Importieren von georeferenzierten Bildern 
1. Wählen Sie Datei > Importieren .Klicken Sie alternativ auf die Schaltfläche 


Importieren  in der Symbolleiste. 
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Das Fenster Importieren wird rechts im Fenster von Trimble Business Center 
angezeigt. 


2. Klicken Sie im Fenster Importieren auf die Schaltfläche Durchsuchen . 


3. Markieren Sie im Dialog Ordner suchen den Ordner C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data und klicken Sie auf OK. 


Der Inhalt des Ordners Importing GNSS Data wird in der Liste Datei(en) auswählen 
im Fenster Importieren angezeigt. 


4. Markieren Sie in der Liste Datei(en) auswählen die Datei Westmoore2.tif und klicken 
Sie auf Importieren. 


Klicken Sie im Mitteilungsdialog Importfehler auf Nein. Das Foto wird in der 
Planansicht dargestellt. 


 


Falls das Bild nicht korrekt dargestellt wird (z. B. als schwarzes Rechteck), müssen 
Sie eventuell die Anzeigeauflösung des Bildes verringern, um den für die Anzeige 
erforderlichen Speicher zu verringern. Eine geringere Anzeigeauflösung führt zu 
einer geringeren Bildqualität, die sich jedoch nicht auf die Bildgröße in der 
Planansicht auswirkt. In vielen Fällen ist die Qualitätsänderung mit bloßem Auge 
nicht zu erkennen. 


Da es sich bei Westmoore2.tif um ein hochauflösendes Bild handelt, können Sie eine 
geringere Auflösung wählen, ohne die Darstellungsqualität zu beeinträchtigen. 
Wählen Sie Extras > Optionen. Klicken Sie im Dialog Optionen auf Erweitert. 
Wählen Sie im Dialog Erweiterte Grafikoptionen den Eintrag Heruntergerechnet 
und dort 512x512. Klicken Sie dann auf OK und erneut auf OK. 


5. Zoomen Sie mit dem Mausrad wie dargestellt an das Bild heran. 
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Sie können Punkte und Basislinien, die dem Bild überlagert sind, auswählen. 


 


Das Bild selbst lässt sich in der Voreinstellung in der Planansicht nicht auswählen. 


6. So legen Sie fest, dass das Bild in der Planansicht gewählt werden kann: 


a. Wählen Sie Ansicht > Ansichtsfilter-Manager. 


b. Klicken Sie im Ansichtsfilter-Manager auf das Symbol Erweiterte 
Ansichtsfiltereinstellungen . 
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c. Aktivieren Sie im Dialog Erweiterte Ansichtsfiltereinstellungen das 
Kontrollkästchen Auswählbar für Georeferenziertes Bild. Klicken Sie dann auf 
OK. 


 


7. Klicken Sie oben rechts auf ein Bild in der Planansicht, um es auszuwählen. Wählen 
Sie dann im Kontextmenü (Rechtsklick) den Eintrag Eigenschaften. 


Sie können zwei Eigenschaften verändern: 


 Über die Ansichtspriorität können Sie das Bild relativ zu anderen Bildern in den 
Vorder- oder Hintergrund verschieben, indem Sie einen Wert zwischen 1 und 5 
festlegen (1 ist im Vordergrund, 5 im Hintergrund). 


Sie können das Bild auch über sein Kontextmenü in der Planansicht nach vorne 
oder hinten verschieben. 


 Die Einstellung Sichtbar blendet ein Bild in der Planansicht ein oder aus. 


Sie haben nun sämtliche GNSS-Daten in das Projekt importiert. 


8. Wählen Sie Datei > Projekt schließen. 


Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 


Nachdem Sie GNSS-Daten ins Projekt importiert haben, können Sie die GNSS-
Basislinien verarbeiten. Dieser Schritt wird im Tutorium Verarbeiten von GNSS-
Basislinien erklärt. 
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Über dieses Tutorium 
In diesem Tutorium importieren Sie Totalstationsdaten in ein Projekt, das bereits GNSS- 
und Nivellementdaten enthält. Anschließend löschen Sie eine fehlerhafte Aufstellung, 
ändern den Prismentyp einer Beobachtung und sehen sich die Residuen der mittleren 
Winkel an. 


Hinweis: Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie 
einfach auf F1, um die Onlinehilfe aufzurufen. 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Importing Total Station Data.vce. Das 
Projekt enthält bereits GNSS- und Digitalnivellierdaten; auch die Verarbeitung der GNSS-
Basislinien ist bereits erfolgt. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Importing Total Station Data.vce und klicken Sie auf 
Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Sie können nun Totalstationsdaten in das Projekt importieren. 


Schritt 2: Importieren von Totalstationsdaten 
In diesem Tutorium importieren Sie eine Datendatei mit Polygonzugsdaten, die mit einer 
Totalstation erfasst wurden. Aufgrund der Genauigkeit des für die Messung verwendeten 
Instruments müssen Sie jedoch die Vorgabetoleranz für mittlere Winkel erhöhen, bevor 
Sie die Daten importieren. 


1. So erhöhen Sie die Vorgabetoleranz für mittlere Winkel: 


a. Wählen Sie Projekt > Projekteinstellungen. 
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b. Wählen Sie im Navigationsfenster des Dialogs Projekteinstellungen den 
Eintrag Berechnungen > Mittlere Winkel. 


c. Geben Sie im Bereich Toleranz der mittleren Winkel in die Felder 
Horizontalwinkel und Vertikalwinkel den Wert 0°00'05" ein. 


 


Nun können Sie die Daten importieren. 


2. Wählen Sie Datei > Importieren .Klicken Sie alternativ auf die Schaltfläche 
Importieren  in der Symbolleiste. 


Das Fenster Importieren wird rechts im Fenster von Trimble Business Center 
angezeigt. 


3. Klicken Sie im Fenster Importieren auf die Schaltfläche Durchsuchen . 


4. Markieren Sie im Dialog Ordner suchen den Ordner C:\Trimble 
Tutorials\TBC\Data\Importing Total Station Data und klicken Sie auf OK. 


Der Ordner Importing Total Station Data enthält die JXL-Datendatei, die in diesem 
Projekt verwendet wird. 


Der Inhalt des Ordners Importing Total Station Data wird in der Liste Datei(en) 
auswählen im Fenster Importieren angezeigt. 


 


5. Markieren Sie in der Liste Datei(en) auswählen die Datei filloop.jxl und klicken Sie 
auf Importieren. 


Da die Software einen Unterschied zwischen dem Koordinatensystem des Projekts 
und dem Koordinatensystem der Importdatei erkennt, erscheint der Dialog 
Projektkoordinatensystem. 


6. Klicken Sie im Dialog Projektkoordinatensystem auf Details. 
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Der Bericht Koordinatensystemvergleich wird im Browser angezeigt; er enthält die 
Projektwerte und die Importwerte nebeneinander. Unterschiede sind markiert. In 
diesem Tutorium verwenden Sie die Projektwerte. 


7. Schließen Sie den Bericht und aktivieren Sie die Option Vorhandene 
Projektdefinition verwenden im Dialog Projektkoordinatensystem. Klicken Sie 
dann auf OK. 


Der Meldungsdialog Importfehler erscheint und zeigt eine Warnung zum Import an. 
Sie können hier direkt die Import-Zusammenfassung aufrufen.  


8. Klicken Sie dazu im Dialog Importfehler auf Ja. 


Die Import-Zusammenfassung wird in einem Browserfenster geöffnet. 


9. Blättern Sie bis zum Ende des Berichts – dort ist die Warnung zu sehen. 


Die Warnung weist darauf hin, dass eine Standpunktaufstellung (Stationierung) 
unvollständig ist. Während der Messung wurde versehentlich der Aufstellungstyp 
„Standpunktaufstellung, mehrere Anschlusspunkte“ gewählt (das entspricht dem 
Filter (S1)). Stattdessen hätte ein Typ mit nur einem Anschlusspunkt und 
Richtungssätzen gewählt werden müssen (entsprechend Filter (S2)). Sie beheben 
das Problem, indem Sie die erste Aufstellung löschen. 


10. So löschen Sie eine Aufstellung: 


a. Klicken Sie auf die Warnung in der Import-Zusammenfassung, um die 
Stationierung auszuwählen. 


b. Klicken Sie im Fenster von Trimble Business Center mit der rechten Maustaste 
in die Planansicht und wählen Sie Auswahl-Explorer.  


Hinweis: Wenn Sie irgendwo in das Fenster klicken, bevor Sie das Kontextmenü der 
Planansicht per Rechtsklick aufrufen, ist die Stationierung nicht mehr gewählt. 
Außerdem wird bei erneuter Wahl der Warnung im Bericht eine andere Nummer als 
die in der Folge gezeigte verwendet. 


Der Auswahl-Explorer erscheint. Die zu löschende Stationierung ist in der Liste 
Auswahlschnappschuss markiert. 
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c. Klicken Sie mit der rechten Maustaste in der Liste Auswahlschnappschuss auf 
Filter (S1) und wählen Sie Löschen. 


11. Wählen Sie Projekt > Projekt berechnen oder drücken Sie F4, um das Projekt neu 
zu berechnen. 


12. Klicken Sie auf die Schaltfläche Vergrößern  in der Symbolleiste, um den 
Ausschnitt der Planansicht wie hier gezeigt zu vergrößern. Klicken Sie alternativ in 
die Planansicht und zoomen Sie mit dem Mausrad. Drücken Sie das Mausrad und 
bewegen Sie die Maus, um die Punkte in die Anzeigenmitte zu holen. 


 


Bei vergrößertem Ausschnitt können Sie die neu importierten Daten besser 
erkennen. 


13. Wählen Sie Ansicht > Projekt-Explorer. Klicken Sie alternativ auf die Schaltfläche 
Projekt-Explorer  in der Symbolleiste. 


14. Klicken Sie im Projekt-Explorer auf das Pluszeichen vor dem Eintrag Importierte 
Dateien. Klicken Sie dann auf das Pluszeichen vor der neu importierten Datei 
filloop.jxl, um die importierten Daten zu betrachten. 
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Der Knoten Polygonzugnetze zeigt an, dass eine Polygonzugausgleichung in 
Survey Controller durchgeführt wurde. 


 


 


Schritt 3: Anzeigen der Eigenschaften von 
Polygonzugausgleichungen 


1. Klicken Sie im Projekt-Explorer mit der rechten Maustaste auf Polygonzugnetze > 
Fieldcheck (filloop.jxl) und wählen Sie Eigenschaften. 
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Das Fenster Eigenschaften zeigt die Abschlussfehler (Klaffen) und 
Genauigkeitswerte vor und nach der Ausgleichung sowie die Art der Fehlerverteilung, 
die Anfangs-, End- und Zwischenpunkte und den Ausgleichungstyp. Außerdem wird 
angezeigt, ob diese Ausgleichung die letzte Ausgleichung der Punktkoordinaten 
darstellt. 


 


Da in Trimble Access und Survey Controller mehrere Ausgleichungen erfolgen 
können, wird nur eine Ausgleichung für die Punktlösung verwendet. Eine 
Projektdatei, die andere Punkte ausgleicht, kann mehrere Polygonzüge enthalten. 


Im Rahmen einer Polygonzugausgleichung ausgeglichene Punkte weisen den Status 
„festgehalten“ auf. Sie werden bei einer Änderung der Koordinaten der Anfangs- und 
Endpunkte nur dann neu berechnet, wenn Sie eine Ausgleichung nach der Methode 
der kleinsten Quadrate über Vermessung > Netz ausgleichen durchführen. 


Der Status wird im Punkt-Ableitungsbericht für Punkt w angezeigt. Dieser Punkt ist 
von Interesse, da Sie wissen, dass im Außendienst der falsche Prismentyp für die 
Messungen, mit denen der Punkt bestimmt wurde, gewählt worden ist. 


2. So zeigen Sie den Punkt-Ableitungsbericht an: 


a. Klicken Sie auf die Schaltfläche Vergrößern  in der Symbolleiste oder 
verwenden Sie das Mausrad, um den Ausschnitt um den Punkt w in der 
Planansicht zu vergrößern. 


b. Klicken Sie auf den Punkt w und markieren Sie in der Liste den Eintrag Punkt w. 


c. Wählen Sie im Kontextmenü (rechte Maustaste) der Planansicht den Eintrag 
Punkt-Ableitungsbericht. 
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Der Bericht wird in einem Browserfenster angezeigt. Die Anzeigen Zur Berechn. 
verwendet. werden in der Zeile Polygonzug ausgeglichen des Berichts 
ausgegeben. Sie erkennen auch die großen Differenzen zwischen dem Punkt 
und dem mittleren Winkel w-x-w (M11). Dies ist der mittlere Winkel, bei dem der 
falsche Prismentyp eingegeben wurde. Diesen Fehler korrigieren Sie im 
nächsten Schritt. 


 


 


Schritt 4: Korrigieren von fehlerhaften Prismentypen 
Da für die Messungen im mittleren Winkel w-x-w (M11) ein falscher Prismentyp 
eingegeben wurde, müssen Sie diesen Fehler korrigieren. Der Fehler ist auch in der 
Polygonzugausgleichung in der Außendienstsoftware enthalten. Durch das Korrigieren 
des Fehlers wird das Ergebnis der Polygonzugausgleichung ungültig. Daher müssen Sie 
dieses Ergebnis löschen, bevor Sie den Prismentyp ändern. 


Hinweis: Sie können in dieser Software keine Polygonzugsausgleichung durchführen, 
denn diese können nur aus Survey Controller oder Trimble Access importiert werden. 
Allerdings können Sie eine Ausgleichung nach der Methode der kleinsten Quadrate 
vornehmen (siehe Tutorium Ausgleichen von Netzen). Falls es sich um ein 
Einzelprojekt handeln würde, das auf den Koordinaten einer Polygonzugsausgleichung 
basierte, müssen Sie in der Außendienstsoftware den Prismentyp korrigieren und den 
Polygonzug erneut ausgleichen. Anschließend könnten Sie die Datei erneut in das 
Projekt importieren. 


1. Klicken Sie im Projekt-Explorer mit der rechten Maustaste auf Polygonzugnetze > 
Fieldcheck (filloop.jxl) und wählen Sie Polygonzugausgleichungsergebnisse 
löschen. 
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Eine Fehlermarkierung erscheint am Punkt w in der Planansicht, da der Punkt die 
für dieses Projekt spezifizierten Punkttoleranzen überschreitet. 


 


2. Klicken Sie in der Planansicht auf den Punkt w und markieren Sie in der Liste den 
Eintrag Punkt w. Wählen Sie im Kontextmenü (rechte Maustaste) den Eintrag Punkt-
Ableitungsbericht. 


Die ausgeglichenen Polygonzugwerte werden nicht mehr im Bericht angezeigt. Der 
mittlere Winkel w-x-w (M11) wird in roter Schrift gezeigt, da der Punkt die zuvor in 
diesem Tutorium spezifizierten Toleranzen für mittlere Winkel überschreitet. 
Nachdem die Ergebnisse der Polygonzugausgleichung gelöscht sind, können Sie 
den fehlerhaften Prismentyp korrigieren. 


3. Erweitern Sie im Projekt-Explorer den Knoten Importierte Dateien > filloop.jxl > x 
(S7) > Richtungssätze > Satz 1. Wählen Sie dann im Kontextmenü (Rechtsklick) von 
x-w (T161) den Eintrag Eigenschaften. 


Die Eigenschaften der Beobachtung erscheinen im Fenster Eigenschaften. 


 


Sie hätten eine beliebige Beobachtung im mittleren Winkel w-x-w (M11) markieren 
können, da Sie nun aufgefordert werden, alle Beobachtungen zu ändern. 


4. Markieren Sie im Fenster Eigenschaften im Bereich Zielinformationen in der Liste 
Prismentyp den Eintrag Groß, 63,5 mm, neigbar. 
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5. Sie werden gefragt, ob Sie die Prismenänderung für alle anderen Beobachtungen 
des mittleren Winkels übernehmen möchten; klicken Sie auf Ja. 


Die Prismenänderung wird für alle Beobachtungen des mittleren Winkels 
übernommen. Sie müssen das Projekt jetzt neu berechnen. 


6. Wählen Sie Projekt > Projekt berechnen oder drücken Sie F4, um das Projekt neu 
zu berechnen. 


Am Punkt w wird in der Planansicht keine Markierung mehr angezeigt. 


7. Öffnen Sie einen weiteren Punkt-Ableitungsbericht für Punkt w und prüfen Sie die 
Änderungen. 


Sie können nun die Residuen für einen mittleren Winkel im Projekt betrachten. 


Schritt 5: Betrachten von Residuen des mittleren 
Winkels 


Ein mittlerer Winkel ist das Ergebnis des Kombinierens und Mittelns redundanter 
Beobachtungen zum selben Punkt. Sie können Residuen für jeden mittleren Winkel 
anzeigen lassen und bei Bedarf Ausreißer deaktivieren.  


In diesem Tutorium betrachten Sie die Residuen des mittleren Winkels w-x-y (M12) 
.Dieser mittlere Winkel ist in der Planansicht markiert, da er Beobachtungen enthält, 
welche die zuvor in diesem Tutorium spezifizierten Toleranzen für mittlere Winkel 
überschreiten. 


1. Erweitern Sie im Projekt-Explorer den Knoten filloop.jxl > x (S7) > Richtungssätze. 
Wählen Sie dann im Kontextmenü (Rechtsklick) von w-x-y (M12) den Eintrag 
Residuen des mittleren Winkels. 


Der Dialog Residuen des mittleren Winkels erscheint. 
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Für vier Beobachtungen im mittleren Winkel sind Markierungen gesetzt. Sie werden 
die Beobachtungen mit den größten Residuen zuerst deaktivieren und prüfen, ob die 
Markierung der anderen Beobachtungen dadurch verschwindet. 


2. Deaktivieren Sie das Kontrollkästchen für Beobachtung x-y (T170). 


Beim Aktivieren oder Deaktivieren von Beobachtungen werden Mittel und Residuen 
neu berechnet. Sie sehen also sofort die Auswirkung der Änderung. Allerdings 
werden diese Änderungen erst ins Projekt übernommen, wenn Sie auf OK klicken. 


Sie können auf die Schaltfläche Bericht klicken, um den Bericht zum mittleren 
Winkel anzuzeigen; dieser enthält weitere Angaben zu den Beobachtungen. 


3. Klicken Sie im Dialog Beobachtungsstatus ändern auf Ja, um die Änderungen für 
x-y (T172) zu übernehmen. 


Es werden weiterhin Markierungen für x-y (T166) und x-y (T168) angezeigt – Sie 
müssen diese Beobachtungen also ebenfalls deaktivieren. 


4. Deaktivieren Sie das Kontrollkästchen für Beobachtung x-y (T168). 


5. Klicken Sie im Dialog Beobachtungsstatus ändern auf Ja, um die Änderungen für 
x-y (T166) zu übernehmen. 


6. Klicken Sie auf OK. 


7. Wählen Sie Projekt > Projekt berechnen oder drücken Sie F4, um das Projekt neu 
zu berechnen. 


Der mittlere Winkel w-x-y (M12) ist in der Planansicht nicht mehr markiert. 


 


Sie haben nun sämtliche Totalstationsdaten in das Projekt importiert. 


8. Wählen Sie Datei > Projekt schließen. 


Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 
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Über dieses Tutorium 
In diesem Tutorium verarbeiten Sie Basislinien aus bereits importierten GNSS-Daten. 


Hinweise: 


 In diesem Tutorium verarbeiten Sie Basislinien mit Daten, die mit L1- und L2-
Signalen gemessen wurden. Sie können die Schritte im Tutorium auch mit Trimble 
Business Center in der Version Survey Standard nachvollziehen; dabei werden 
aber nur L1-Daten verarbeitet. Um Zweifrequenzdaten (L1 und L2) zu verarbeiten, 
benötigen Sie die Version Survey Advanced. Welche Lizenz installiert ist, können 
Sie unter Hilfe > Über Trimble Business Center und dort Lizenz einsehen. Die 
Liste Funktionen zeigt die lizenzierten Funktionen an. 


 Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie einfach 
auf F1, um die Onlinehilfe aufzurufen. 


 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Processing GNSS Baselines.vce. Die 
GNSS-Daten wurden bereits importiert, aber es wurden noch keine Basislinien 
verarbeitet. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Processing GNSS Baselines.vce und klicken Sie auf 
Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Prüfen Sie vor dem Verarbeiten von Basislinien, ob die 
Basislinienverarbeitungseinstellungen korrekt gewählt sind. 
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Schritt 2: Festlegen des Verarbeitungsintervalls 
Vor dem Verarbeiten von Basislinien können Sie das Intervall (in Sekunden) wählen, in 
dem die Daten ausgewertet werden sollen. Sie können natürlich auch einfach das bei der 
Aufzeichnung verwendete (und in der Datendatei enthaltene) Intervall verwenden. Je 
kürzer das Intervall, desto mehr Daten werden verarbeitet und desto länger dauert die 
Verarbeitung. Mehr Daten bedeuten auch höhere Präzision. Wenn das gewählte Intervall 
kleiner als das Messintervall ist, wird das Messintervall verwendet.  


Im Idealfall verwenden Sie das Intervall der Datendatei, um so das kleinstmögliche 
Intervall zu nutzen. Bei langen Besetzungszeiten mit Intervallen (Epochen) von 
1 Sekunde oder weniger kann sich daraus jedoch eine sehr lange Verarbeitungsdauer 
ergeben. In diesem Fall können Sie das Intervall verlängern und so die 
Berechnungsdauer verkürzen. In diesem Tutorium verwenden Sie ein Intervall von 
5 Sekunden, um eine möglichst kurze Verarbeitungsdauer zu erreichen.  


1. Wählen Sie Projekt > Projekteinstellungen. Klicken Sie alternativ auf die 
Schaltfläche Projekteinstellungen  in der Symbolleiste. 


2. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Basislinienverarbeitung > Verarbeitung. 


3. Wählen Sie in der Liste Verarbeitungsintervall die Option 5 (Sekunden). 


 


Sie können die Basislinienverarbeitung über weitere Optionen beeinflussen. Der 
untere Teil des Dialogs enthält hilfreiche Tipps. Mit F1 können Sie jederzeit in die 
Onlinehilfe wechseln. Nehmen Sie im Rahmen dieses Tutoriums keine weiteren 
Änderungen vor. 


4. Klicken Sie auf OK, um den Dialog Projekteinstellungen zu schließen. 


Nun können Sie die Basislinien verarbeiten. 


Schritt 3: Verarbeiten von Basislinien 
1. Wählen Sie Vermessung > Basislinien verarbeiten. Klicken Sie alternativ auf die 


Schaltfläche Basislinien verarbeiten  in der Symbolleiste. 
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Hinweis: Falls Sie bei Wahl des Befehls Basislinien verarbeiten keine Basislinien 
in den Ansichten markiert haben (wie in diesem Fall), werden alle Basislinien des 
Projekts verarbeitet. Falls Basislinien markiert sind, werden nur diese Basislinien 
verarbeitet. 


Der Dialog Basislinien verarbeiten erscheint mit einer Fortschrittsanzeige. 


 


Nach der Verarbeitung werden die verarbeiteten Basislinien in der Tabelle 
aufgeführt. Sie können die Basislinien durch Anklicken der Spaltenköpfe sortieren. 
Um Basislinien nach ihrer Genauigkeit zu sortieren, klicken Sie einfach auf die 
Spaltenköpfe Horiz. Genauigkeit und Vert. Genauigkeit. 


Weitere Daten zu einer bestimmten Basislinie erhalten Sie, indem Sie die 
entsprechende Zeile markieren und über die Schaltfläche Bericht den 
Basislinienverarbeitungsbericht als HTML-Seite im Browser öffnen. 


Hinweis: Wenn Sie den Basislinienverarbeitungsbericht anderswo in Trimble 
Business Center öffnen, wird er im RDLC-Format (Report Definition Language 
Client-side) in einem Ansichtsregister geöffnet; aus dieser Ansicht können Sie den 
Bericht als PDF-Datei speichern. 


2. Klicken Sie im Dialog Basislinien verarbeiten auf Speichern, um die verarbeiteten 
Basislinien zu speichern. 


Das Projekt wird mit den neu erstellten Basislinien neu berechnet. 


Sie können den Punkt-Ableitungsbericht öffnen, um die Punktkoordinaten 
anzuzeigen.  


3. Markieren Sie den Punkt fsi in der Planansicht. Wählen Sie im Kontextmenü (rechte 
Maustaste) den Eintrag Punkt-Ableitungsbericht. 


Der Punkt-Ableitungsbericht wird im Internetbrowser angezeigt. 


Falls für eine Basislinie eine Fehlermarkierung im Dialog Basislinien verarbeiten 
erscheint, müssen Sie die Daten dieser Basislinie prüfen (Antennentyp, Antennenhöhe, 
Punktname usw.). Manchmal wird eine Fehlermeldung durch erneutes Berechnen der 
Basislinie behoben, falls dabei ein anderer Koordinatenursprung verwendet wird. Je nach 
dem eigentlichen Problem können Sie diverse Maßnahmen ergreifen – bis hin zum 
Bearbeiten der zugehörigen Sitzung. 
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Im nächsten Abschnitt bearbeiten Sie eine Sitzung (Besetzung) und verarbeiten eine 
Basislinie erneut, so als wenn eine Fehlermarkierung im Dialog Basislinien verarbeiten 
angezeigt worden wäre. Dadurch können Sie sich mit dem Besetzungseditor vertraut 
machen. 


Schritt 4: Bearbeiten von Sitzungen und erneutes 
Verarbeiten von Basislinien 


Im Besetzungseditor können Sie die Qualität der Satellitenrohdaten einer markierten 
Sitzung visuell überprüfen. Lücken in den Satellitendaten können auf Phasensprünge, 
ungültige Messungen und andere Signalprobleme hinweisen. Mit dem Besetzungseditor 
können Sie schlechte („unhealthy“) Satelliten deaktivieren, Bereiche mit schlechten 
Satellitendaten ausklammern und Besetzungszeiten anpassen, um die Qualität 
verarbeiteter Basislinien zu optimieren. 


In diesem Schritt bearbeiten Sie die Sitzung einer Basislinie, um Lücken im 
Satellitensignal zu korrigieren. Anschließend verarbeiten Sie die Basislinie erneut.  


Hinweis: Diese Schritte dienen dazu, Ihnen den Umgang mit dem Besetzungseditor zu 
vermitteln. In einem echten Projekt müssten Sie die Beispiel-Basislinie nicht erneut 
verarbeiten, da sie innerhalb der Annahmekriterien des Projekts liegt. 


1. Klicken Sie in die Planansicht und zoomen Sie mit dem Mausrad hinein, bis Sie die 
Basislinie zwischen den Punkten fsi und 3 erkennen können. Klicken Sie dann auf 
die Basislinie und wählen Sie im Kontextmenü den Eintrag Basislinie fsi --- 3 (B15). 


 


2. Wählen Sie im Kontextmenü (Rechtsklick) der Planansicht den Eintrag 
Besetzungseditor. 
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Der Dialog Besetzungseditor erscheint. 


 
Satelliten, deren Daten in der Sitzung enthalten sind, werden als blaue und/oder 
grüne Linien im Zeitdiagramm dargestellt. Jede blaue Linie steht für Daten, die am 
ersten Punkt der Basislinie erfasst wurden (fsi). Jede grüne Linie steht für Daten, die 
am zweiten Punkt der Basislinie erfasst wurden (3). 


Jeder Satellit wird durch einen Buchstaben und eine Ziffer in der linken Spalte 
markiert: 


 G = GPS-Satellit 


 R = Glonass-Satellit 


 E = Galileo-Satellit  


Beachten Sie, dass das Signal von Satellit G7 mitten in der Sitzung endet. Der 
Satellit ist zu diesem Zeitpunkt vermutlich hinter dem Horizont verschwunden. 
Obwohl es eigentlich nicht erforderlich wäre, deaktivieren Sie zu Übungszwecken die 
Daten von Satellit G7. 


3. Klicken Sie in der linken Spalte auf G7. 


Klicken Sie auf OK. Die gesamte Zeile wird eingefärbt, um anzuzeigen, dass die 
Satellitendaten deaktiviert sind (also nicht in der Verarbeitung verwendet werden). 


Deaktivieren Sie nun einen Teil der Daten der Satelliten R17 und R18, da diese 
durch Unterbrechungen der blauen und grünen Linien dargestellte Phasensprünge 
aufweisen. 


4. Klicken Sie in der Zeile R17 vor den ersten Sprung und ziehen Sie den Cursor bis 
zum Ende der Zeile. 
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5. Markieren Sie in der Zeile R18 die Phasensprünge zu Beginn der Sitzung ebenfalls 
durch Klicken und Ziehen. 


 


Auf diese Weise deaktivieren Sie die Satellitendaten nur für die markierte Basislinie. 
Um einen Satelliten in allen Basislinien eines Projekts zu deaktivieren, wählen Sie 
Projekt > Projekteinstellungen. Wählen Sie dann Basislinienverarbeitung > 
Satelliten und entfernen Sie das Häkchen vor dem zu deaktivierenden Satelliten. 
Hier können Sie auch die Höhenmaske verändern, um die Basislinienergebnisse zu 
beeinflussen. 


6. Klicken Sie auf OK, um den Dialog Besetzungseditor zu schließen. 


Nun können Sie die Basislinie erneut verarbeiten. 


7. Achten Sie darauf, dass die Basislinie fsi --- 3 (B15) noch markiert ist; wählen Sie 
dann Vermessung > Basislinien verarbeiten. Klicken Sie alternativ auf die 
Schaltfläche Basislinien verarbeiten  in der Symbolleiste. 


Der Dialog Basislinien verarbeiten erscheint und die markierte Basislinie wird 
erneut verarbeitet. 


8. Klicken Sie nach der Verarbeitung auf Speichern. 


Sie haben die GNSS-Basislinien nun verarbeitet. Im nächsten Abschnitt bestimmen und 
deaktivieren Sie abhängige Basislinien im Projekt. 


Schritt 5: Bestimmen und Deaktivieren abhängiger 
Basislinien 


Wenn Sie nur unabhängige Basislinien in der Netzausgleichung verwenden möchten, 
können Sie die abhängigen Basislinien in der zeitbasierten Ansicht bestimmen und 
deaktivieren. 


Hinweis: Wenn Sie eine Basislinie deaktivieren, wird der zugehörige Vektor gelöscht. 
Soll der Vektor erhalten bleiben, müssen Sie diesen anstelle der Basislinie deaktivieren. 
Anleitungen zum Deaktivieren von Vektoren sind nicht Teil des Tutoriums. 


Betrachten Sie die Abbildung der Messdaten in diesem Projekt. 
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Die eingekreisten Zahlen geben die Sitzung an, in der die Basislinien gemessen wurden. 
In Sitzung 1 wurden die Punkte fsi, 5, frey und hanna besetzt. Die Gesamtzahl der 
Basislinien, die während einer Sitzung beobachtet werden können, ist  


 
wobei n der Anzahl der Empfänger entspricht, die in der Sitzung verwendet wurden. 


Wenn Sie zum Beispiel vier Empfänger in einer Sitzung benutzt haben, können damit 
sechs Basislinien beobachtet werden (4 mal 3 geteilt durch 2). 


Die Anzahl unabhängiger Basislinien für eine bestimmte Sitzung ist . 


In diesem Projekt wurden pro Sitzung drei unabhängige Basislinien gemessen. In den 
fünf beobachteten Sitzungen wurden insgesamt 30 Basislinien gemessen, von denen 
lediglich 15 unabhängig sind.  


Bei Einsatz der CORS-Station müssen Sie einen weiteren Empfänger berücksichtigen. 
Damit ergeben sich pro Sitzung 10 Basislinien, von denen vier Stück unabhängig sind. 
Insgesamt wurden in allen Sitzungen zusammen 50 Basislinien (20 unabhängige) 
gemessen. 


So deaktivieren Sie abhängige Basislinien: 


1. Wählen Sie Ansicht > Neue zeitbasierte Ansicht. Klicken Sie alternativ auf die 
Schaltfläche Neue zeitbasierte Ansicht  in der Symbolleiste. 
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Die zeitbasierte Ansicht erscheint. Die folgende Abbildung zeigt die Sitzungen 1 
und 2. (Die weiteren Sitzungen werden in der Abbildung nicht gezeigt.) 


 


Sie können die Maus zum Navigieren in der zeitbasierten Ansicht verwenden: 


 Platzieren Sie den Cursor über einer Sitzung und drücken Sie das Mausrad; 
bewegen Sie die Maus vor und zurück, um den Ausschnitt horizontal zu 
verschieben. 


 Verschieben Sie den Ausschnitt durch Scrollen mit dem Mausrad vertikal nach 
oben und unten. 


 Platzieren Sie den Cursor über einer Sitzung und verschieben Sie die Maus bei 
gedrückter linker Taste nach oben, um hineinzuzoomen, oder nach unten, um 
herauszuzoomen. 


 Nach einem Rechtsklick werden weitere Zoomoptionen angezeigt. 
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2. Stellen Sie sicher, dass Sie die richtige Sitzung gewählt haben, indem Sie in der 
linken Spalte bei gedrückter Umschalttaste klicken, um alle Basislinien aus 
Sitzung 1 zu markieren. 


 


3. Klicken Sie bei gedrückter Strg-Taste, um die unabhängigen Basislinien in 
Sitzung 1 abzuwählen. Dies sind die Basislinien, die Sie nicht deaktivieren 
möchten. 


 P041 --- hanna  
Da Sie die Beobachtung von P041 zu den Punkten im Außenbereich des Netzes 
verwenden, müssen Sie diese Basislinie abwählen. 


 5 --- fsi  


 hanna --- frey  
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 5 --- frey  


 


4. Wählen Sie im Kontextmenü (Rechtsklick) der weiteren markierten Basislinien aus 
Sitzung 1 den Eintrag Basislinien deaktivieren. 


Eine Meldung informiert Sie darüber, dass die zugehörigen Vektoren gelöscht 
werden.  


5. Klicken Sie im Mitteilungsdialog Vektoren löschen auf Ja. 


6. Die deaktivierten Basislinien werden in der zeitbasierten Ansicht als dunkelgraue 
Balken dargestellt. 
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7. Wiederholen Sie diesen Vorgang für die Sitzungen 2 bis 5. Achten Sie darauf, alle 
abhängigen Basislinien zu deaktivieren. 


Die unabhängigen Basislinien der einzelnen Sitzungen sind in der Folge aufgeführt. 
Markieren Sie diese Basislinien nicht, da sie nicht deaktiviert werden sollten. 
Markieren Sie alle anderen Basislinien zum Deaktivieren. 


Sitzung 2: 


 3 --- filter  


 P041 --- sixtwo  


 3 --- sixtwo  


 sixtwo --- hanna  


Sitzung 3: 


 hanna --- filter 


 filter --- 5 


 filter --- frey  


 P041 --- frey  


Sitzung 4: 


 P041 --- fsi  


 fsi --- 3  


 3 --- sixtwo  


 3 --- 5  


Sitzung 5: 


 P041 --- sixtwo  


 frey --- hanna  


 frey --- 5  


 sixtwo --- hanna  


Nachdem Sie die Basislinien deaktiviert haben, müssen Sie das Projekt neu 
berechnen. 


8. Wählen Sie Projekt> Projekt berechnen. Sie können auch F4 drücken. 


Beachten Sie, dass in der Planansicht Hinweismarkierungen an den Punkten 5 und 
fsi erscheinen. 


 


9. Wählen Sie Ansicht > Markierungsfenster. 
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Im Markierungsfenster ist erkennbar, dass bei zwei Punkten die horizontalen 
Punkttoleranzen des Projekts überschritten wurden.  


 


In diesem Tutorium ändern Sie die Toleranz, sodass die Markierungen nicht mehr 
angezeigt werden.  


10. So ändern Sie horizontale und vertikale Toleranzen für Punkte im Projekt: 


a. Wählen Sie Projekt > Projekteinstellungen. Klicken Sie alternativ auf die 
Schaltfläche Projekteinstellungen  in der Symbolleiste. 


b. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Berechnungen. 


c. Ändern Sie im Bereich Vermessungsqualität den Wert im Feld Horizontale 
Toleranz (Vermessung) in 0,025 m. Ändern Sie den Wert im Feld Vertikale 
Toleranz (Vermessung) in 0,055 m. 


d. Klicken Sie auf OK. 


Die Markierungen werden nicht länger in der Planansicht oder im 
Markierungsfenster angezeigt. 


11. So zeigen Sie nur die aktivierten Beobachtungen und Basislinien (für das 
Postprocessing) in der Planansicht an: 


a. Wählen Sie Planansicht. 


b. Wählen Sie Ansicht > Ansichtsfilter-Manager. 


Der Ansichtsfilter-Manager erscheint. 


 


c. Klicken Sie unten im Fenster auf das Register Beobachtungen und wählen Sie 
Nur aktivierte Beobachtungen. 


d. Klicken Sie unten im Fenster auf das Register GNSS-Anzeigestil und wählen 
Sie Nur aktivierte Basislinien (für Auswertung). 


e. Klicken Sie in die Planansicht und zoomen Sie mit dem Mausrad. Drücken Sie 
das Mausrad und bewegen Sie die Maus, um die in der zweiten Abbildung 
gezeigten Punkte in die Anzeigenmitte zu holen. 
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Planansicht vor dem Filtern der Ansicht: 


 


Planansicht nach dem Filtern der Ansicht: 


 


Sie haben nun die abhängigen Basislinien im Projekt deaktiviert. 


12. Wählen Sie Datei > Projekt schließen. 


Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 
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Über dieses Tutorium 
In diesem Tutorium legen Sie ein neues Projekt an, nehmen diverse Projekteinstellungen 
vor und speichern das Projekt als Vorlage für künftige Projekte. 


Hinweis: Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie 
einfach auf F1, um die Onlinehilfe aufzurufen. 


Schritt 1: Anlegen eines neuen Projekts 
1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 


Neues Projekt. 


Der Dialog Neues Projekt wird angezeigt. 


 


2. Vergewissern Sie sich, dass <Leere Vorlage> in der Liste markiert ist; klicken Sie 
dann auf OK. 
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Die Planansicht wird im Fenster von Trimble Business Center angezeigt. Sie 
können nun die Konfigurationseinstellungen für das Projekt festlegen. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Schritt 2: Festlegen der Projekteinstellungen 
Sie können die unterschiedlichsten Einstellungen für das neue Projekt festlegen. In 
diesem Tutorium ändern Sie die Projekteinstellungen Koordinatensystem, Einheit, 
Basislinienverarbeitung und Ansicht. Alle anderen Projekteinstellungen bleiben 
unverändert. 
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Sie rufen den Dialog Projekteinstellungen über Projekt > Projekteinstellungen auf. 
Klicken Sie alternativ auf die Schaltfläche Projekteinstellungen  in der Symbolleiste. 


 


 


2a: Festlegen der Koordinatensystemeinstellungen 
In diesem Schritt wählen Sie das Koordinatensystem für das Projekt aus. 


1. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Koordinatensystem. 


2. Klicken Sie auf die Schaltfläche Ändern. 
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Wenn Sie schon einmal ein Koordinatensystem gewählt hatten, enthält der Dialog 
Koordinatensystem auswählen eine Liste der zuvor gewählten Systeme. Klicken 
Sie in diesem Fall auf die Option Neues System und dann auf Weiter. 


 


Falls Sie bisher noch nie ein System gewählt hatten oder Sie im Dialog 
Koordinatensystem auswählen auf Neues System geklickt haben, erscheint der 
Dialog Koordinatensystemtyp auswählen. 


3. Wählen Sie im Dialog Koordinatensystemtyp auswählen den Eintrag 
Koordinatensystem und Zone. Klicken Sie dann auf Weiter. 


Der Dialog Koordinatensystemzone wählen erscheint. 


 


4. Gehen Sie so vor: 
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a. Wählen Sie in der Liste Koordinatensystemgruppe den Eintrag US State Plane 
1983. 


b. Wählen Sie in der Liste Zone den Eintrag Colorado North 0501. 


c. Klicken Sie auf Weiter. 


Der Dialog Geoidmodell auswählen erscheint. 


 


5. Gehen Sie so vor: 


a. Wählen Sie die Option Vordefiniertes Geoid. 


b. Wählen Sie in der Liste den Eintrag GEOID03 (Conus). 


Der Coordinate System Manager ist ein Standalone-Dienstprogramm, das 
Ihnen Zugriff auf Ihre Koordinatensystemdatenbank gewährt (Current.csd). Sie 
können im Coordinate System Manager Geoidmodelle definieren. Das 
definierte Modell wird im Dialog Geoidmodell auswählen ausgewählt. 


c. Klicken Sie auf die Schaltfläche Fertig stellen. 


Der Dialog Projekteinstellungen zeigt die gewählten Koordinatendaten im Abschnitt 
Zusammenfassung des Fensters Koordinatensystem. 


2b: Festlegen der Einheiten 
Über die Einheiteneinstellungen wählen Sie die Einstellungen für Koordinaten, Strecken 
und GPS-Zeiten im Projekt. 
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1. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Einheiten > Koordinate. Wählen Sie dann in der Liste Anzeigereihenfolge 
den Eintrag Hochwert, Rechtswert, orthometrische Höhe. 


 


2. Wählen Sie im Navigationsfenster des Dialogs Projekteinstellungen die Option 
Einheiten > Strecke. Wählen Sie dann in der Liste Anzeige den Eintrag Meter. 
Wählen Sie in der Liste Fußdefinition den Eintrag US Vermessungsfuß. 


3. Wählen Sie im Navigationsfenster des Dialogs Projekteinstellungen die Option 
Einheiten > GPS-Zeit. Wählen Sie dann in der Liste Anzeige den Eintrag GPS. 


 


2c: Festlegen der Basislinienverarbeitungseinstellungen 
Jetzt legen Sie die horizontalen und vertikalen Toleranzen für Markierungen oder Fehler 
bei der Basislinienverarbeitung fest. 


1. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Basislinienverarbeitung > Qualität. 


 


2. Geben Sie die Annahmekriterien wie folgt ein: 


a. Aktivieren Sie das Kontrollkästchen Wenn Horizontalgenauigkeit und geben 
Sie folgende Werte ein: 
- Markierung: 0,020 m + 1,0 ppm 
- Fehlgeschlagen: 0,050 m + 1,0 ppm 


b. Aktivieren Sie das Kontrollkästchen Wenn vertikale Genauigkeit und geben Sie 
folgende Werte ein: 
- Markierung: 0,050 m + 1,0 ppm 
- Fehlgeschlagen: 0,100 m + 1,0 ppm 
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2d: Festlegen der Ansichtseinstellungen 
In diesem Schritt ändern Sie die Farbe der Rasterlinien in der Planansicht. Sie beziehen 
außerdem Netz-/Grundeigenschaften in die Punkttabelle und maximale PDOP-Werte für 
verarbeitete Vektoren in die Vektortabelle ein. 


1. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Ansicht > Planansicht > Gitterliniendefinition. 


 


2. Wählen Sie in der Liste Linienfarbe den Eintrag Magentarot. 


Die Rasterlinien in der Planansicht werden nun magentarot gezeichnet und sind 
beim Betrachten von Fotos einfacher zu erkennen.  


3. Wählen Sie im Navigationsfenster des Dialogs Projekteinstellungen die Option 
Ansicht > Punktetabelle. 


 


4. Blättern Sie zum Abschnitt Netz-/Grundeigenschaften und aktivieren Sie die 
Anzeige des kombinierten Maßstabsfaktors in der Punktetabelle. 
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5. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Ansicht > Vektortabelle. 


 


6. Blättern Sie zum Abschnitt Beobachtete Daten und aktivieren Sie die Anzeige des 
maximalen PDOP-Werts in der Vektortabelle. 


7. Klicken Sie auf OK. 


Sie haben nun alle Projekteinstellungen festgelegt. Wenden wir uns jetzt einigen 
Anpassungsoptionen zu. 


Schritt 3: Festlegen von Anzeige- und 
Anpassungsoptionen 


Beim Anlegen eines neuen Projekts sollten Sie prüfen, ob die Anzeigeoptionen korrekt 
gesetzt sind.  


1. Wählen Sie Extras > Optionen. 
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Der Dialog Optionen erscheint. 


 


Sie können die Optionen in diesem Dialog ändern, um die Darstellung in den 
verschiedenen Programmanzeigen anzupassen. Die Änderungen gelten 
projektübergreifend bis zur nächsten Änderung. 


2. Klicken Sie auf Erweitert, um den Dialog Erweiterte Grafikoptionen zu öffnen. 


Dort können Sie die Darstellung von Grafiken (z. B. Fotos) im Projekt steuern. Wenn 
sehr große Bilddateien aufgrund von Speicherbeschränkungen nicht korrekt 
dargestellt werden, können Sie hier die Anzeigegröße verringern. Im Rahmen dieses 
Tutoriums nehmen Sie keine Änderungen vor. 


3. Klicken Sie auf Abbrechen, um den Dialog Erweiterte Grafikoptionen zu schließen. 
Klicken Sie dann auf Abbrechen, um den Dialog Optionen zu schließen. 


4. Wählen Sie Werkzeuge > Anpassen. 
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Der Dialog Benutzerdefiniert einrichten erscheint. 


 


Sehen Sie sich die diversen Register und Schaltflächen im Dialog an. (Sie müssen 
jetzt keine Änderungen vornehmen.) 


 Register Symbolleisten: Auf diesem Register legen Sie fest, welche 
Symbolleisten angezeigt werden oder erstellen eigene Symbolleisten. 


 Register Befehle: Aus diesem Register können Sie Befehle direkt in Menüs oder 
auf Symbolleisten ziehen oder Menübefehle und Symbolleistenschaltflächen neu 
anordnen. 


 Register Optionen: Auf diesem Register können Sie die Darstellung von Menüs 
und Symbolleisten anpassen. 


 Register Benutzerdefinierte Extras: Auf diesem Register erstellen Sie Befehle, 
die andere installierte Programm öffnen. 


 Register Speichern/Laden: Auf diesem Register können Sie Symbolleisten und 
Menülayouts erstellen und speichern. 


 Schaltfläche Tastatur: Über diese Schaltfläche verwalten Sie 
Tastenkombinationen. 


5. Klicken Sie auf Schließen, um den Dialog Benutzerdefiniert einrichten zu 
schließen. 


Sie sollten Ihr neues Projekt jetzt speichern und benennen. 
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Schritt 4: Speichern von Projekten 
1. Wählen Sie Datei > Projekt speichern .Klicken Sie alternativ auf die Schaltfläche 


Projekt speichern  in der Symbolleiste. 


2. Navigieren Sie im Dialog Speichern unter zum Ordner ..\Eigene Dateien\Trimble 
Business Center, in dem die Projektdateien üblicherweise abgelegt werden. 


3. Geben Sie in das Feld Dateiname den Projektnamen ein, in unserem Beispiel 
Setting Up a Project YourName.vce. Klicken Sie dann auf Speichern. 


Das Fenster von Trimble Business Center enthält nun den Namen des Projekts in 
der Titelleiste. 


 


Im nächsten Abschnitt lernen Sie, wie Sie das neue Projekt als Vorlage für künftige 
Projekte speichern können. 


Schritt 5: Erstellen von Projektvorlagen 
Wenn Sie in der Zukunft weitere Projekte im selben geografischen Gebiet durchführen 
werden, können Sie die Projekteinstellungen als Projektvorlage speichern. 


1. Wählen Sie Datei > Projekt als Vorlage speichern. 


Der Dialog Projekt als Vorlage speichern wird angezeigt. 


 


2. Geben Sie im Feld Name einen Namen ein, in unserem Beispiel Setting Up 
Template. 
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Wenn Sie möchten, dass neue Projekte diese Vorlage automatisch nutzen, aktivieren 
Sie das Kontrollkästchen Projekt als Standardvorlage speichern. 


Im Rahmen des Tutoriums müssen Sie keine Projektvorlage speichern. Klicken Sie 
daher im nächsten Schritt nicht – wie sonst üblich – auf Speichern, um die Vorlage 
zu speichern, sondern klicken Sie auf Schließen. 


Hinweis: Nachdem Sie eine Vorlage gespeichert haben, können Sie diese weiter 
anpassen (zum Beispiel durch Ändern von Projekteinstellungen). Diese Änderungen 
werden beim nächsten Verwenden der Vorlage übernommen. 


3. Klicken Sie auf Schließen, um den Dialog zu schließen, ohne die Vorlage zu 
speichern. 


4. Wählen Sie Datei > Projekt schließen. 
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Über dieses Tutorium 
In diesem Tutorium betrachten Sie Tabellen, erstellen Sie einen Auswahlsatz und 
arbeiten Sie mit Kleinpunktsteuerelementen. 


Hinweis: Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie 
einfach auf F1, um die Onlinehilfe aufzurufen. 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Using Spreadsheets.vce. Das Projekt 
enthält bereits GNSS-, Totalstations- und Nivellierdaten; auch die Verarbeitung der 
GNSS-Basislinien ist bereits erfolgt. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Using Spreadsheets.vce und klicken Sie auf Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Sie können nun einige Funktionen von Trimble Business Center kennenlernen. 


Schritt 2: Betrachten von Tabellen 
In diesem Schritt betrachten Sie zwei Tabellen in Trimble Business Center: 


 Aufstellungstabelle 


 Punkttabelle 


Sie können die Tabellenanzeige wie in den folgenden Schritten erklärt anpassen.  







 Schritt 2: Betrachten von Tabellen  


Tutorium zu Trimble Business Center – Verwenden von Tabellen, Auswahlsätzen und 
Kleinpunktsteuerelementen 5 


1. Wählen Sie Projekt > Projekteinstellungen. Klicken Sie alternativ auf die 
Schaltfläche Projekteinstellungen  in der Symbolleiste. 


2. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen die 
Option Ansicht > Punktetabelle. 


Die Tabelle enthält eine Liste der Namen der Spalten in der Punktetabelle. Hinter 
jedem Spaltennamen wird angezeigt, ob die Spalte in der Tabelle angezeigt wird 
oder nicht. 


 


Sie können auf diese Anzeigen zum Ein- und Ausblenden klicken, um den 
Tabelleninhalt zu ändern. 


Im Navigationsfenster (links) des Dialogs Projekteinstellungen können Sie weitere 
Tabellen im Menü Ansicht auswählen, um auch deren Spaltenanzeige zu ändern. Im 
Rahmen dieses Tutoriums nehmen Sie keine Änderungen vor. 


3. Klicken Sie auf Abbrechen, um den Dialog Projekteinstellungen zu schließen. 


In der Folge wählen Sie eine andere Tabellensortierung. 


4. Wählen Sie Ansicht > Neue Punktetabelle. Klicken Sie alternativ auf die 
Schaltfläche Neue Punktetabelle  in der Symbolleiste. 


Die Punktetabelle erscheint. 


 


Sie können die Zeilen sortieren, indem Sie auf die Spaltenköpfe klicken. In der 
Grundeinstellung sind die Zeilen alphabetisch nach Punktnamen sortiert. 
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5. Klicken Sie auf den Spaltenkopf Höhe, um die Zeilen auf- oder absteigend nach der 
Punkthöhe zu sortieren. 


Das Symbol Sortieren  gibt an, ob die Sortierung aufsteigend (Aufwärtspfeil) oder 
absteigend (Abwärtspfeil) erfolgt. 


Sie können die dargestellten Zeilen über die Filterschaltfläche  anhand einer Spalte 
filtern. Der Vorgabefilter lautet Alles. 


6. Klicken Sie auf das Filtersymbol Objektcode  und wählen Sie im Kontextmenü den 
Eintrag Nicht leer. 


 


Jetzt werden nur noch Punkte mit Objektcodes in der Tabelle angezeigt. 


Sie können die Tabelle noch weiter anpassen: 


 Ändern Sie die Spaltenbreite, indem Sie den Cursor auf einer Spaltengrenze in 
der Titelzeile platzieren und diese nach links oder rechts verschieben. 


 Verschieben Sie Spalten per Ziehen und Ablegen mit der Maus. 


 Verschieben Sie das Tabellenregister an eine andere Position. Klicken Sie dazu 
einfach auf die Registerbeschriftung und ziehen Sie diese nach unten von der 
Registerleiste weg, bevor Sie die Maustaste loslassen. Wählen Sie anschließend 
im Kontextmenü eine neue Position aus. 


Mit Neue vertikale Registergruppe zeigen Sie das Register vertikal im Fenster 
an. 


Auf die gleiche Art und Weise können Sie das Register wieder an die 
ursprüngliche Position verschieben. 


In der Tabelle blau angezeigte Inhalte können bearbeitet werden. Sie können also 
einen neuen Punktnamen eingeben oder einen Objektcode bearbeiten – direkt in 
der Spalte oder durch Anklicken von , um den Objektcode-Editor zu öffnen. 


Sie können auch Tabellenzeilen kopieren und in eine Microsoft-Excel-Tabelle 
einfügen. Dazu markieren Sie einfach die gewünschten Zeilen und drücken Strg+C. 
Markieren Sie dann eine Zelle in der Excel-Tabelle und drücken Sie zum Einfügen 
Strg+V. Sie können die Titelzeile zwar nicht markieren, aber sie wird automatisch 
kopiert und eingefügt. 


Um die Eigenschaften eines Punktes anzuzeigen, markieren Sie eine Zeile und 
wählen im Kontextmenü (Rechtsklick) den Eintrag Eigenschaften. 


Mit benutzerdefinierten Filtern können Sie die Filterkriterien für die anzuzeigenden 
Daten festlegen. Im folgenden Beispiel werden nur Punkte angezeigt, die nicht mit 
dem Antennentyp R8 GNSS/SPS88x Intern beobachtet wurden. 


7. Wählen Sie Ansicht > Neue Aufstellungstabelle. Klicken Sie alternativ auf die 
Schaltfläche Neue Aufstellungstabelle  in der Symbolleiste. 
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Die Aufstellungstabelle erscheint. 


 


8. Klicken Sie auf die Filterschaltfläche Ant.- Typ  und wählen Sie im Kontextmenü 
Benutzerdefiniert. 


Der Dialog Filterkriterien eingeben für Ant.- Typ erscheint. 


 


9. Wählen Sie in der Liste Operator den Eintrag Nicht gleich. 


10. Wählen Sie in der Liste Operand den Eintrag R8 GNSS/SPS88x Intern .Klicken Sie 
dann auf OK. 


Die Tabelle wird wunschgemäß gefiltert. Nur Punkte, bei denen der Antennentyp R8 
GNSS/SPS88x Intern nicht verwendet wurde, sind enthalten. 


 
Sie haben nun die Tabellen betrachtet. Wenden wir uns jetzt dem Erstellen und 
Verwenden von Auswahlsätzen zu. 
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Schritt 3: Erstellen von Auswahlsätzen 
Wenn Sie dieselben Objekte immer wieder auswählen müssen, ist es lästig und 
fehleranfällig, dies von Hand zu tun. Stattdessen können Sie den Auswahl-Explorer 
benutzen, um Auswahlsätze zu erstellen und erneut zu verwenden. 


1. Klicken Sie in die Planansicht. 


2. Klicken Sie auf die Schaltfläche Vergrößern , um die hier gezeigte Ansicht zu 
erreichen. Klicken Sie alternativ in die Planansicht und zoomen Sie mit dem 
Mausrad. Drücken Sie das Mausrad und bewegen Sie die Maus, um die Punkte in 
die Anzeigenmitte zu holen. 


 


3. Wählen Sie Ansicht > Auswahl-Explorer. Klicken Sie alternativ auf die Schaltfläche 
Auswahl-Explorer  in der Symbolleiste. 
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Der Auswahl-Explorer erscheint. 


 


Der Auswahl-Explorer enthält zwei Listen: 


 Die Liste Auswahlsätze in der oberen Fensterhälfte und 


 die Objektliste in der unteren Fensterhälfte. Letztere zeigt die in der Planansicht 
markierten oder die in den gewählten Auswahlsätzen enthaltenen Objekte an. 


4. Ziehen Sie in der Planansicht mit dem Cursor einen Auswahlrahmen um die 
Objekte, die der Auswahlsatz enthalten soll (siehe Abbildung). 
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Die Auswahl erscheint im Auswahl-Explorer in der Objektliste 
<Auswahlschnappschuss>. 


 


5. Klicken Sie in der Symbolleiste des Auswahl-Explorers auf die Schaltfläche 
Auswahlliste speichern unter . 


6. Geben Sie im Dialog <Auswahlschnappschuss> speichern unter einen Namen für 
den neuen Auswahlsatz ein: <IhrName> Auswahl .Klicken Sie dann auf OK. 


Der neue Auswahlsatz wird zur Liste Auswahlsätze hinzugefügt. Zum Betrachten 
der im Auswahlsatz enthaltenen Objekte markieren Sie den Satz einfach in der Liste 
Auswahlsätze. 
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Sie können die Eigenschaften jeden Objekts im Auswahlsatz aufrufen, indem Sie es 
in der Liste markieren und im Kontextmenü des Objekts (Rechtsklick) den Eintrag 
Eigenschaften wählen. Verwenden Sie die Tastenkombinationen [Umschalttaste] + 
Klicken oder [Strg] + Klicken um mehrere Objekte zu markieren. Das Markieren 
mehrerer Objekte ist besonders nützlich, wenn Sie eine bestimmte Eigenschaft (zum 
Beispiel einen Objektcode) für all diese Objekte gleichzeitig (und einheitlich) ändern 
möchten. 


Zum Markieren mehrerer Objekte in mehreren Auswahlsätzen drücken Sie die Strg-
Taste und nehmen die Auswahl in der Liste Auswahlsätze vor. 


Sie können die weiteren Schaltflächen in der Symbolleiste des Auswahl-Explorers 
verwenden, um Objekteigenschaften anzuzeigen, Auswahlsätze zu löschen oder 
Objekte zu Auswahlsätzen hinzuzufügen oder daraus zu entfernen. Weitere 
Informationen finden Sie in der Onlinehilfe. 


7. Schließen Sie den Auswahl-Explorer. 


Sie haben nun das Arbeiten mit Auswahlsätzen kennengelernt. Wenden wir uns jetzt 
einigen nützlichen Kleinpunktsteuerelementen zu. 


Schritt 4: Arbeiten mit Kleinpunktsteuerelementen 
Kleinpunktsteuerelemente sind Felder in verschiedenen Befehlen, mit denen Sie Winkel, 
Richtungen, Koordinaten, Strecken, Höhen und Offsets im Projekt berechnen können 
(Kleinpunktberechnung oder Koordinatengeometrie). Sie können damit auf 
unterschiedlichem Wege Daten eingeben, zum Beispiel: 


 Eingeben von Werten und Punktnamen in das Feld 


 Auswählen von Punkten in Grafikansichten 


 Rechtsklicken in Grafikansichten und Auswählen zusätzlicher Fang- und 
Kleinpunktoptionen im Kontextmenü 


Kleinpunktsteuerelemente sorgen für mehr Flexibilität, damit Sie Daten auf 
unterschiedlichste Weise eingeben können, anstatt sich durch Befehlsfolgen zu arbeiten. 


Fangbefehle nutzen geometrische Berechnungen, um Sie beim exakten und schnellen 
Angeben von Koordinaten zu unterstützen. Fangmodi können sich auf vorhandene 
Geometrie oder im Befehl eingegebene Parameter stützen. Fangbefehle stehen immer 
dann zur Verfügung, wenn Sie Koordinaten eingeben müssen. Nach einem Rechtsklick 
werden die verfügbaren Optionen angezeigt. 


In dieser Anleitung erstellen Sie vier neue Projektpunkte (1, 2, 6 und 7) mit 
verschiedenen Kleinpunktsteuerelementen und Fangbefehlen von Trimble Business 
Center. Vor dem Erstellen der Punkte prüfen Sie, ob die korrekten Fangmodi gesetzt 
sind. 


1. Klicken Sie in der Statusleiste unten im Fenster von Trimble Business Center auf 
die Schaltfläche Fang. 
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Der Dialog Optionen für ständige Fangmodi erscheint. 


 


In diesem Dialog können Sie die Fangmodi einrichten. Eine Beschreibung aller 
Optionen wird im Dialog angezeigt. 


In dieser Anleitung verwenden Sie Fangbefehle zum Auswählen von Punkten. Damit 
Sie auch wirklich einen Punkt (und nicht nur eine Koordinate in seiner Nähe) wählen, 
deaktivieren Sie den Modus Frei. Da diese Einstellungen systemweit gelten (und 
nicht nur für das Projekt) werden Sie nach den folgenden Schritten den Modus Frei 
wieder aktivieren. 


2. Verfahren Sie im Dialog Optionen für ständige Fangmodi wie folgt: 


a. Stellen Sie sicher, dass der Punktmodus gewählt ist. 


b. Deaktivieren Sie die Option Frei. 


c. Klicken Sie auf OK. 


3. So erstellen Sie Punkt 1: 


a. Wählen Sie Punkt > Punkt erstellen. 


Das Fenster Punkt erstellen erscheint. 


 


b. Stellen Sie sicher, dass das Feld Punktname den Namen 1 enthält, dass das 
Feld Objektcode leer ist und der Koordinatentyp Gitter lautet. 


c. Klicken Sie rechts in das Feld Hochwert. 


d. Wählen Sie im Kontextmenü den Eintrag Peilung-Abstand-Fang. 
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Das Fenster Peilung Abstand-Fang erscheint. Über dieses Steuerelement 
berechnen Sie einen Punkt über einen Ausgangspunkt, eine Peilung und einen 
Abstand. Die Peilung 0 (Null) entspricht der Nordrichtung. Peilungen werden als 
Gitterazimut im Uhrzeigersinn gemessen. 


 


e. Klicken Sie in das Feld Referenzpunkt und markieren Sie Punkt 5 in der 
Planansicht. 


Die Koordinate für Punkt 5 erscheint im Feld. Sie können auch einfach die 5 in 
das Feld eingeben. 


f. Geben Sie im Feld Richtung den Wert S37 44 56E (oder im Azimutfeld den Wert 
142 15 04) ein. 


g. Geben Sie im Feld Strecke den Wert 290,91sft  ein.Klicken Sie dann auf OK. 


Bei der Eingabe haben Sie auch die Längeneinheit sft angegeben. Das ist 
erforderlich, wenn Sie eine andere Einheit als die in den Projekteinstellungen 
festgelegte verwenden möchten. 


Die Koordinaten für den neuen Punkt 1 erscheinen im Fenster Punkt erstellen. 
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h. Klicken Sie auf die Schaltfläche Hinzufügen. 


Der neue Punkt 1 erscheint in der Planansicht. Das Fenster Punkt erstellen ist 
leer; Sie können einen weiteren Punkt erstellen. 


 


4. So erstellen Sie Punkt 2: 


a. Stellen Sie im Fenster Punkt erstellen sicher, dass im Feld Punktname der 
Name 2 angezeigt wird. 


b. Klicken Sie rechts in das Feld Hochwert. 


c. Wählen Sie im Kontextmenü den Eintrag Peilung-Abstand-Fang. 


Das Fenster Peilung Abstand-Fang erscheint. 


 


d. Geben Sie im Feld Referenzpunkt den Wert 3 ein. 


e. Geben Sie im Feld Richtung den Wert N18 05 08E ein. 


f. Geben Sie im Feld Strecke den Wert 322,91sft  ein.Klicken Sie dann auf OK. 


Die Koordinaten für den neuen Punkt 2 erscheinen im Fenster Punkt erstellen. 


g. Klicken Sie auf die Schaltfläche Hinzufügen. 
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Der neue Punkt 2 erscheint in der Planansicht. 


 


Sie können nun den neuen Punkt 6 erstellen, die auf halber Strecke zwischen den 
Punkten 1 und 2 liegt. 


5. So erstellen Sie Punkt 6: 


a. Geben Sie im Fenster Punkt erstellen ins Feld Punktname den Namen 6 ein. 


b. Klicken Sie rechts in das Feld Hochwert. 


c. Wählen Sie im Kontextmenü den Eintrag Mitte-von-Punkten-Fang. 


Das Fenster Mitte-von-Punkten-Fang erscheint. Dieses Steuerelement 
berechnet eine Position auf halber Strecke zwischen zwei Punkten. 


 


d. Geben Sie im Feld Von-Punkt den Wert 1 ein. 


e. Geben Sie im Feld Zu-Punkt den Wert 2 ein. Klicken Sie dann auf OK. 


Die Koordinaten für den neuen Punkt 6 erscheinen im Fenster Punkt erstellen. 


f. Klicken Sie auf die Schaltfläche Hinzufügen. 
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Der neue Punkt 6 erscheint in der Planansicht. 


 


Sie können jetzt den neuen Punkt 7 erstellen. 


6. So erstellen Sie Punkt 7: 


a. Geben Sie im Fenster Punkt erstellen ins Feld Punktname den Namen 7 ein. 


b. Klicken Sie rechts in das Feld Hochwert. 


c. Wählen Sie im Kontextmenü den Eintrag Peilung-Peilung-Fang. 


Das Fenster Peilung Peilung-Fang erscheint. Über dieses Steuerelement 
können Sie den Schnittpunkt zweier Peilungen von zwei Punkten aus berechnen. 


 


d. Geben Sie im Feld Referenzpunkt 1 den Wert 5 ein. 


e. Klicken Sie rechts in das Feld Richtung 1. 


f. Wählen Sie im Kontextmenü den Eintrag Richtung + Winkel-Fang. 
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Das Fenster Richtung + Winkel-Fang erscheint. Über dieses Steuerelement 
berechnen Sie eine Peilung durch Addieren eines Winkels zu einer gegebenen 
Peilung. 


 


g. Klicken Sie rechts in das Feld Richtung. 


h. Wählen Sie im Kontextmenü den Eintrag Punkt-zu-Punkt-Peilung-Fang. 


Das Fenster Punkt-zu-Punkt-Peilung-Fang erscheint. Mit diesem 
Steuerelement berechnen Sie die Peilung von einem Punkt zu einem anderen. 


 


i. Geben Sie im Feld Referenzpunkt 1 den Wert 5 ein. 


j. Geben Sie im Feld Referenzpunkt 2 den Wert fsi ein. Klicken Sie dann auf OK. 


Das Fenster Richtung + Winkel-Fang mit der neuen Richtung 1 erscheint. 


 


k. Geben Sie im Feld Winkel den Wert 5 (= 5 Grad) ein. Klicken Sie dann auf OK. 
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Das Fenster Peilung Peilung-Fang erscheint. 


 


l. Geben Sie im Feld Referenzpunkt 2 den Wert 3 ein. 


m. Klicken Sie rechts in das Feld Richtung 2. 


n. Wählen Sie im Kontextmenü den Eintrag Punkt-zu-Punkt-Peilung-Fang. 


Das Fenster Punkt-zu-Punkt-Peilung-Fang erscheint. 


 


o. Geben Sie im Feld Referenzpunkt 1 den Wert 3 ein. 


p. Geben Sie im Feld Referenzpunkt 2 den Wert 6 ein. Klicken Sie dann auf OK. 
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Das Fenster Richtung-Richtung-Fang mit der neuen Richtung 2 erscheint. 


 


q. Klicken Sie auf OK. 


Die Koordinaten für den neuen Punkt 7 erscheinen im Fenster Punkt erstellen. 


 


r. Klicken Sie auf die Schaltfläche Hinzufügen. 
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Der neue Punkt 7 erscheint in der Planansicht. 


 


Sie können jetzt den Fangmodus Frei wieder aktivieren, falls er für andere Projekte 
benötigt wird. 


7. So aktivieren Sie den Fangmodus Frei: 


a. Klicken Sie in der Statusleiste unten im Fenster von Trimble Business Center 
auf die Schaltfläche Fang. 


b. Aktivieren Sie im Dialog Optionen für ständige Fangmodi den Modus Frei. 


c. Klicken Sie auf OK. 


Sie haben nun das Arbeiten mit Kleinpunktsteuerelementen kennengelernt. Nehmen 
Sie sich ruhig noch ein wenig Zeit, die weiteren Funktionen von Trimble Business 
Center auf eigene Faust zu entdecken. Während der Arbeit mit der Software können 
Sie jederzeit über F1 die Onlinehilfe aufrufen. 


8. Wenn Sie fertig sind, wählen Sie einfach Datei > Projekt schließen. 


Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 
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Über dieses Tutorium 
Ein Korridor ist ein 3D-Modell einer lang gestreckten Struktur, bspw. einer Straße oder 
eines Wasserlaufs. Der Korridor beruht auf einem horizontalen und (optional) einem 
vertikalen Kurvenband. Er enthält Vorlagen (Schablonen), die Querprofile für die gesamte 
Länge des Korridors definieren. 


In diesem Tutorium erstellen Sie einen Trassenkorridor auf Basis einer vorhandenen 
Oberfläche und Trassierung (Kurvenband). 


Hinweise: 


 Das in der Folge beschriebene Erstellen eines Korridors mit Materialschichten kann 
nur mit der Lizenz Survey Advanced von Trimble Business Center durchgeführt 
werden. Mit der Lizenz Survey Standard können Sie nur Korridore ohne 
Materialschichten erstellen. Welche Lizenz installiert ist, können Sie unter Hilfe > 
Über Trimble Business Center und dort Lizenz einsehen. Die Liste Funktionen 
zeigt die lizenzierten Funktionen an. 


 Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie einfach 
auf F1, um die Onlinehilfe aufzurufen. 


 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Working with Corridors.vce. Das 
Projekt enthält eine Oberfläche und ein Kurvenband, aus denen Sie einen neuen 
Trassenkorridor erstellen werden. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Working with Corridors.vce und klicken Sie auf Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Schritt 2: Festlegen des Neigungsverhältnistyps für 
das Projekt 


Da Korridore Neigungen enthalten, müssen Sie prüfen, ob der richtige 
Neigungsverhältnistyp eingestellt ist. Mögliche Typen sind „Hoch zu Längs“ und „Längs 
zu Hoch“. 


1. Wählen Sie Projekt > Projekteinstellungen. 
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2. Wählen Sie im Navigationsfenster (links) des Dialogs Projekteinstellungen den 
Eintrag Einheiten > Vertikalwinkel. 


 


Der Neigungsverhältnistyp ist als Hoch zu Längs eingestellt. Diese Einstellung 
wird für das Tutorium benötigt; Sie müssen also keine Änderung vornehmen. 


3. Klicken Sie auf die Schaltfläche Abbrechen. 
 


Schritt 3: Filtern der Ansicht 
Um das Kurvenband und die Oberfläche besser zu sehen, können Sie RTK-Vektoren und 
Punkte in der Ansicht ausblenden. 


1. Wählen Sie Ansicht > Ansichtsfilter-Manager. 


Der Ansichtsfilter-Manager zeigt alle Rohdatenobjekte, die eingeblendet sind. 


 


2. Deaktivieren Sie in der Liste Rohdaten die Einträge RTK-Vektor und Punkt. 
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Die Änderungen werden in die Planansicht übernommen. 


 


3. Schließen Sie den Ansichtsfilter-Manager. 
 


Schritt 4: Erstellen von Vorlagenknotennamen 
Bevor Sie den neuen Korridor erstellen, sollten Sie die Namen für die verschiedenen 
Knoten in Korridor-Querprofilvorlagen definieren. 


Sie können die Vorlagenknotennamen auch während des Erstellens der Korridorvorlagen 
definieren, aber wenn Sie dies bereits im Vorfeld erledigen, wird die Vorlagenerstellung 
beschleunigt. Außerdem können Sie auf diese Weise eine Bibliothek von Knotennamen 
anlegen, die Sie in allen Projekten verwenden können. Erstellen Sie einfach die 
möglicherweise benötigten Namen und speichern Sie das Projekt als Vorlage. Die 
Namen stehen dann in jedem Projekt, das Sie auf Basis der Vorlage anlegen, zur 
Verfügung. Anleitungen zum Erstellen von Projektvorlagen finden Sie im Tutorium 
Einrichten von neuen Projekten. 


In dieser Anleitung erstellen Sie zwei neue Vorlagenknotennamen. 


1. Wählen Sie Korridor > Vorlagenknotennamen verwalten. Klicken Sie alternativ auf 
die Schaltfläche Vorlagenknotennamen verwalten  in der Symbolleiste. 


2. Klicken Sie im Fenster Vorlagenknotennamen verwalten unten auf die Schaltfläche 
Neu. (Möglicherweise müssen Sie blättern, damit die Schaltfläche sichtbar wird.) 
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Eine neue Zeile wird zur Liste hinzugefügt. 


 


3. Geben Sie den Namen Fahrspur ein.  


4. Wiederholen Sie die Schritte 2 und 3, um den Namen Geländeschnittpunkt 
einzugeben. 


5. Klicken Sie auf Schließen. 


Nun erstellen Sie eine neue Materialschicht für den Korridor. 


Schritt 5: Erstellen von Materialschichten 
Sie können im Projekt verfügbare Materialschichten für verschiedene Oberflächen im 
Korridor definieren. Sie können neben Standardschichten für das Feinplanum weitere 
Schichten für die Tragschicht, den stabilisierten Untergrund oder das Planum definieren. 


Für jede Anweisung in einer Korridorvorlage (siehe weiter unten) können Sie eine oder 
mehrere Materialschichten auswählen; die im Rahmen der Anweisung erzeugten 
Liniensegmente werden in dieser/n Schicht/en platziert. 


Beim Erstellen oder Bearbeiten von Korridoren können Sie die aktuelle Materialschicht in 
der Liste Layer auswählen. Diese Schicht wird in Planansicht und 3D-Ansicht 
angezeigt. Beim Exportieren des Korridors wird diese Schicht zum Erzeugen der 
Korridoroberfläche verwendet. Die Liniensegmente in der aktuellen Materialschicht 
werden beim Erzeugen der Korridoroberfläche verwendet. 


In dieser Anleitung erstellen Sie eine neue Materialschicht für den Korridor. 


1. Wählen Sie Korridor > Materialschichten verwalten. Klicken Sie alternativ auf die 
Schaltfläche Materialschichten verwalten  in der Symbolleiste. 


Das Fenster Materialschichten verwalten erscheint. Die Standardschicht Fertig 
(Feinplanum) erscheint in der Liste Materialschichten. 


 


2. Klicken Sie auf die Schaltfläche Neu. 


Eine neue Zeile wird zur Liste Materialschichten hinzugefügt. 
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3. Geben Sie im Feld Name den Namen Untergrund ein. 


4. Klicken Sie auf Schließen. 


Sie können nun einen neuen Korridor erstellen. 


Schritt 6: Erstellen von Korridoren 
In dieser Anleitung erstellen Sie einen Korridor für eine Trasse auf Basis der Oberfläche 
und des Kurvenbands im Projekt. 


1. Wählen Sie Korridor > Korridor erstellen. Klicken Sie alternativ auf die Schaltfläche 
Korridor erstellen  in der Symbolleiste. 


Das Fenster Korridor erstellen erscheint. 


 


2. Geben Sie im Feld Name den Namen Trasse01 ein. 


CL ist das einzige Kurvenband in diesem Projekt und wird daher automatisch in die 
Listen Horizontales Kurvenband und Vertikales Kurvenband übernommen. 


3. Markieren Sie in der Schichtliste Aktuelles Material den Eintrag Fertig. 


Diese Schicht wird in Planansicht und 3D-Ansicht angezeigt. 


Eine im Projekt enthaltene CAD-Polylinie dient als Referenzlinie für den neuen 
Korridor. Sie können Offsets auf Grundlage dieser Linie erzeugen. 


4. Klicken Sie auf die Schaltfläche +/–. 


Das Fenster Referenzlinien bearbeiten erscheint. 
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5. Klicken Sie in das Feld Hinzuzufügende oder zu entfernende Linien markieren. 
Klicken Sie dann auf die blaue CAD-Polylinie in der Planansicht. Wählen Sie im 
Kontextmenü den Eintrag CAD-Polylinie. 


Zoomen Sie bei Bedarf mit dem Mausrad hinein. 


 


Das Feld zeigt an, das ein Objekt markiert ist. 


 


6. Klicken Sie auf die Schaltfläche Hinzufügen. 


Eine Meldung informiert Sie darüber, dass das markierte Objekt als Referenzlinie 
zum neuen Korridor hinzugefügt wurde. 


7. Klicken Sie auf Schließen. 


Die Anzahl der zum Korridor gehörenden Referenzlinien wird im Fenster Korridor 
erstellen angezeigt. 


 


8. Aktivieren Sie in der Liste Referenzoberflächen das Kontrollkästchen Vorhanden. 


9. Klicken Sie auf OK. 
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Das Fenster Korridorvorlage einfügen erscheint. 


 


Sie können nun eine Querprofilvorlage (Regelquerschnitt) in den neuen Korridor 
einfügen. 


Schritt 7: Einfügen von Korridorvorlagen 
Sie können Querprofilvorlagen (Regelquerschnitte) für Korridore erstellen und einfügen. 
(Pro Station kann jedoch nur eine Vorlage eingefügt werden.) Vorlagen enthalten 
Anweisungen, die das Querprofil für einen bestimmten Längenabschnitt des Korridors 
definieren, beispielsweise Abstände und Neigungen einer Straße. 


In dieser Anleitung erstellen Sie eine einzelne Vorlage, die den Korridor ab Station 0+00 
definiert. 


1. Markieren Sie im Fenster Korridorvorlage einfügen in der Liste Korridor den 
Eintrag Trasse01. 


2. Geben Sie im Feld Anfangsstationierung den Wert 0 ein. 


Sobald Sie das Feld verlassen, wird die 0 durch das eingestellte Stationsformat 
0+00,00 ersetzt. Die neue Vorlage wird an Station 0+00,00 in den Korridor eingefügt 
und bis zur nächsten Vorlage oder bis zum Ende des Korridors benutzt. 


3. Wählen Sie in der Liste Optionen den Eintrag Neue Definition. 
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4. Geben Sie im Feld Vorlagenname den Namen Vorlage01 ein. 


 


5. Klicken Sie auf die Schaltfläche Einfügen. 


Das Fenster Korridorvorlage bearbeiten erscheint. Das Fenster besteht aus drei 
Bereichen: (1) Vorlagengrafik, (2) Anweisungsliste und (3) 
Anweisungseigenschaften. 


 







 Schritt 8: Erstellen von Anweisungen für Korridorvorlagen  


Tutorium zu Trimble Business Center – Arbeiten mit Korridoren 12 


Die grüne Linie in der Grafikansicht entspricht der Projektoberfläche. Der Achsknoten 
1[CL] wird automatisch auf Basis des für den Korridor genutzten horizontalen 
Kurvenbandes erzeugt und zur Vorlage hinzugefügt. Außerdem wurde der Knoten 2 
etwa 5 Meter links von 1[CL] auf Basis der einen CAD-Polylinie, die Sie dem Korridor 
bereits hinzugefügt haben, erzeugt. 


 


6. Wählen Sie Ansicht > Projekt-Explorer. Klicken Sie dann im Projekt-Explorer auf 
das Pluszeichen vor dem Knoten Korridore und dem Knoten Trasse01, um den 
neuen Vorlagenknoten anzuzeigen. 


 


7. Schließen Sie den Projekt-Explorer. 
 


Schritt 8: Erstellen von Anweisungen für 
Korridorvorlagen 


Nachdem Sie eine Querprofilvorlage erstellt und in den neuen Korridor eingefügt haben, 
können Sie Anweisungen definieren, die festlegen, wie das Querprofil in diesem 
Korridorabschnitt verläuft (Abstände und Neigungen). 


Korridorvorlagen bestehen aus Knoten und Anweisungen. Knoten definieren die 
verschiedenen Abstände und Neigungen in den Vorlagen. So kann der Korridor für eine 
einfache Straßentrasse drei Knoten enthalten: eine Achse auf Basis des Kurvenbandes 
(1), den rechten Deckenrand (2) und den linken Deckenrand (3). 
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Die Software erzeugt einige Knoten automatisch auf Basis des Kurvenbands und der 
Referenzlinien im Korridor. So wurde Knoten 1 aus der obigen Abbildung automatisch als 
Korridorachse aus dem Kurvenband erzeugt. 


Sie können weitere benötigte Knoten zum Definieren von Abständen und Neigungen für 
weitere Merkmale des Korridors erstellen. Knoten 2 in der obigen Abbildung wurde zum 
Beispiel manuell als rechte Deckenkante mit einem Abstand von etwa 3 m und einer 
Neigung von –2 % relativ zur Achse erstellt. Um einen Knoten manuell zu erstellen, 
definieren Sie Anweisungen mit Abstand und Neigung des Knotens relativ zu anderen 
Knoten in der Vorlage. 


In dieser Anleitung erstellen Sie eine Korridorvorlage, indem Sie zuerst die Knoten und 
Linien auf der rechten Seite für die Materialschichten „Fertig“ und „Untergrund“ 
definieren. Über „Anweisungen spiegeln“ kopieren Sie dieselben Knoten und Linien auf 
die Seite links der Achse. 


8a: Definieren der rechten Fahrspur (Schicht „Fertig“) 
1. Wählen Sie in der Liste Anweisungstyp im Fenster Korridorvorlage bearbeiten 


den Eintrag Abstand/Neigung. 


Dieser Anweisungstyp dient zum Erstellen eines Vorlagenknotens über Abstand und 
Neigung von einem anderen Knoten aus. In diesem Fall dient der Achsknoten (CL), 
der automatisch für das Kurvenband erzeugt wurde, als Ausgangspunkt. 


2. Wählen Sie im Feld Abstand/Neigung von den Eintrag <Vorheriger Knoten>. 


Wenn Sie <Vorheriger Knoten> wählen, wird der Knoten, der über die vorherige 
Anweisung in der Anweisungsliste erstellt wurde, referenziert. Wenn die Liste keine 
vorherige Anweisung enthält, wird der Knoten referenziert, der automatisch für das 
horizontale Kurvenband erzeugt wurde (in diesem Fall 1[CL]. 


3. Auf der Schaltfläche Abstand muss das Symbol Abstand  zu sehen sein. Geben 
Sie dann in das Feld den Wert 12 ein. 


Der neue Knoten wird damit 12 Fuß rechts vom Knoten 1[CL] (Achse) erzeugt. Um 
den Knoten 12 Fuß links vom Knoten 1[CL] (Achse) zu erzeugen, müssen Sie –12 
eingeben. 


4. Klicken Sie auf den Auswahlpfeil auf der Schaltfläche Neigung und wählen Sie 
Tabelle . Klicken Sie dann auf Tabelle . 


Das Fenster Stationierungs-/Neigungstabelle erscheint. Geben Sie in diesem 
Fenster die Neigung zwischen dem Knoten 1[CL] und dem neuen Knoten an 
bestimmten Stationen im Korridor zwischen der aktuellen Vorlage und der nächsten 
Vorlage (bzw. dem Ende des Korridors) an. 


 


5. Geben Sie im Fenster Stationierungs-/Neigungstabelle die folgenden Werte ein. 
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Hinweis: Sie müssen dabei nicht das hier gezeigte Format verwenden. Statt 0+00,00 
können Sie einfach 0 eingeben. Statt 4+33,00 können Sie einfach 433 eingeben. Für 
eine Neigung von –2,00% können Sie einfach –2 eingeben. Das korrekte Format wird 
automatisch angewandt, wenn der Cursor die Zelle verlässt. 


Station Neigung 
0+00,00 –2,00% 
0+50,00 –2,00% 
0+75,00 –4,00% 
1+32,00 –4,00% 
1+50,00 –2,00% 
4+33,00 –2,00% 
4+53,00 –4,00% 
5+17,00 –4,00% 
5+36,00 –2,00% 


Eine negative Neigung gibt an, dass der Knoten unterhalb der Achse erzeugt wird. 


 


Klicken Sie abschließend auf OK. 


6. Wählen Sie in der Liste Name den Eintrag Fahrspur. 


Dieser Knoten entspricht der rechten Kante der rechten Fahrspur. 


7. Markieren Sie in der Liste Materialschichten den Eintrag Fertig. 


8. Klicken Sie auf die Schaltfläche Hinzufügen.  
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Das neu erzeugte Knoten 3[Fahrspur] erscheint in der Vorlagenansicht. Die 
Anweisung zum Erzeugen des Knotens erscheint in der Liste Anweisungen. Klicken 
Sie in die Grafikansicht und zoomen Sie mit dem Mausrad auf den neuen Knoten. 
Der Korridor wird nun auch in der Planansicht angezeigt. 


 


Die Felder in den Eigenschaften des Fensters Korridorvorlage bearbeiten sind 
wieder leer, sodass Sie eine weitere Anweisung eingeben können. 


8b: Definieren des rechten Banketts (Schicht „Fertig“) 
1. Wählen Sie in der Liste Anweisungstyp den Eintrag Abstand/Neigung. 


2. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Abstand/Neigung von:  <Vorheriger Knoten> 
In diesem Fall bezeichnet <Vorheriger Knoten> den neu erzeugten Knoten 
3[Fahrspur]. 


 Abstand > Abstand :  6  


 Neigung > Neigungsprozent : –4 
Klicken Sie auf den Auswahlpfeil auf der Schaltfläche Neigung und wählen Sie 
Neigungsprozent. Das Minuszeichen vor dem Wert gibt an, dass die Neigung 
vom Knoten 3[TL] nach unten verläuft (= Gefälle). 


 Name: Bankett 
Da Sie Bankett nicht als Korridorcode im Korridorcodemanager definiert haben, 
können Sie den Namen einfach ins Feld Code eingeben. 
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 Materialschichten: Fertig 


 


3. Klicken Sie auf die Schaltfläche Hinzufügen. 


Der neu erzeugte Knoten 4[Bankett] entspricht der rechten Kante des Banketts am 
rechten Rand der Fahrspur. 


 


 


8c: Definieren der rechten Entwässerungsneigung (Schicht 
„Fertig“) 


1. Wählen Sie in der Liste Anweisungstyp den Eintrag Abstand/Neigung. 


2. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Abstand/Neigung von:  <Vorheriger Knoten> 
In diesem Fall bezeichnet <Vorheriger Knoten> den neu erzeugten Knoten 
4[Bankett]. 


 Abstand > Abstand : 5 
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 Neigung > Neigungsprozent : –20 
Klicken Sie auf den Auswahlpfeil auf der Schaltfläche Neigung und wählen Sie 
Neigungsprozent. Das Minuszeichen vor dem Wert gibt an, dass die Neigung 
vom Knoten 4[Bankett] nach unten verläuft (= Gefälle). 


 Name: Graben 
Sie müssen diesen neuen Code in das Feld eingeben. 


 Materialschichten: Fertig 


3. Klicken Sie auf die Schaltfläche Hinzufügen. 


Der neu erzeugte Knoten 5[Graben] entspricht der rechten Kante der 
Entwässerungsneigung am rechten Rand des Banketts. 


 


Sie können nun das Seitengefälle für die rechte Seite der Korridorvorlage definieren. 
Die Seitenböschungsanweisung definiert einen Seitenböschungsknoten über ... 


 Abtragsneigung und gegebenenfalls Grabenbreite 


 Auftragsneigung 


Der Seitenböschungsknoten gibt den Schnittpunkt von Abtrags- oder 
Auftragsneigung mit einer Zieloberfläche an. 


8d: Definieren der rechten Seitenböschung (Schicht „Fertig“) 
1. Wählen Sie in der Liste Anweisungstyp den Eintrag Seitengefälle. 


2. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Seitenböschung von: <Vorheriger Knoten> 
In diesem Fall bezeichnet <Vorheriger Knoten> den neu erzeugten Knoten 
5[Graben]. 


 Zieloberfläche: Vorhanden 
Damit schneidet die Seitenböschung die vorhanden Oberfläche. 


 Abtragsneigung > Neigungsverhältnis : 1:2 
Gemäß den Projekteinstellungen ist der Neigungstyp „Hoch zu Längs“. 


 Abtragsgrabenbreite: 3 
Dieser Wert gibt an, dass im Falle eines Auftrags ein 3 Fuß breiter Graben 
enthalten ist. 


 Auftragsneigung > Neigungsverhältnis : 1:5 







 Schritt 8: Erstellen von Anweisungen für Korridorvorlagen  


Tutorium zu Trimble Business Center – Arbeiten mit Korridoren 18 


 Name: Geländeschnittpunkt  


 Materialschichten: Fertig 


3. Klicken Sie auf die Schaltfläche Hinzufügen. 


 


Die Seitenböschung erstreckt sich nun bis zum Schnittpunkt mit der Oberfläche, der 
je nach Station in einem anderen Abstand liegt. Abhängig vom Verlauf der 
Oberfläche kommt es entweder zu einem Abtrag oder zu einem Auftrag. Im Falle 
eines Auftrags ist gemäß der Anweisung ein 3 Fuß breiter Graben enthalten. 


Sie haben nun die Materialschicht „Fertig“ für die rechte Seite der Vorlage definiert. 
Nun erstellen Sie die Materialschicht „Untergrund“ für die rechte Seite. 


8e: Definieren der Achse (Schicht „Untergrund“) 
Verfahren Sie im Fenster Korridorvorlage bearbeiten wie folgt: 


1. Wählen Sie in der Liste Anweisungstyp den Eintrag Abstand/Höhe. 


2. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Abstand/Höhe von:  1[CL] 


 Abstand > Abstand :  0 
Der Abstand von 0 stellt sicher, dass der neue Untergrundknoten direkt über 
oder unter dem Knoten 1[CL] liegt (je nach Höhe). 


 Höhe > Höhenunterschied : –,5 
Klicken Sie auf den Auswahlpfeil auf der Schaltfläche Höhe und wählen Sie 
Höhenunterschied. Das Minuszeichen vor dem Wert gibt an, dass der neue 
Knoten 0,5 Fuß unter dem Knoten 1[CL] liegt. 


 Name: CL UG 
Geben Sie den neuen Code in das Feld ein. 


 Materialschichten: keine Auswahl 
Indem Sie keine Materialschicht wählen, stellen Sie sicher, dass keine Linie 
zwischen 1[CL] und dem neuen Knoten erzeugt wird. 


3. Klicken Sie auf die Schaltfläche Hinzufügen. 
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Der neu erzeugte Knoten 7[CL UG] markiert die Achse in der Materialschicht 
„Untergrund“. 


 


 


8f: Definieren der rechten Fahrspur (Schicht „Untergrund“) 
1. Wählen Sie in der Liste Anweisungstyp den Eintrag Abstand/Höhe. 


2. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Abstand/Höhe von:  3[Fahrspur] 


 Abstand > Abstand :  0 


 Höhe > Höhenunterschied : –,5 


 Name: Fahrspur UG 


 Materialschichten: keine Auswahl 


3. Klicken Sie auf die Schaltfläche Hinzufügen. 


Der neu erzeugte Knoten 8[Fahrspur UG] markiert die rechte Kante der rechten 
Fahrspur in der Materialschicht „Untergrund“. 
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8g: Definieren des rechten Banketts (Schicht „Untergrund“) 
1. Wählen Sie in der Liste Anweisungstyp den Eintrag Abstand/Höhe. 


2. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Abstand/Höhe von:  4[Bankett] 


 Abstand > Abstand :  0 


 Höhe > Höhenunterschied : –,5 


 Name: Bankett UG 


 Materialschichten: keine Auswahl 


3. Klicken Sie auf die Schaltfläche Hinzufügen. 


Der neu erzeugte Knoten 9[Bankett UG] markiert die rechte Kante des rechten 
Banketts in der Materialschicht „Untergrund“. 


 


Jetzt verbinden Sie die neu erzeugten Untergrundknoten mit Liniensegmenten. 


8h: Verbinden von Knoten (Schicht „Untergrund“) 
In dieser Anleitung definieren Sie ein Liniensegment, dass die Knoten 7[CL UG] und 8[TL 
UG] miteinander verbindet. 


1. Wählen Sie in der Liste Anweisungstyp den Eintrag Verbinden. 


2. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Von Knoten:  7[CL UG]  
Sie können den Knotennamen in der Liste auswählen oder den Knoten in der 
Vorlagengrafik markieren. 


 Zu Knoten:  8[Fahrspur UG] 


 Materialschichten: Untergrund  
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3. Klicken Sie auf die Schaltfläche Hinzufügen. 


 


Jetzt definieren Sie ein Liniensegment, dass die Knoten 8[TL UG] und 9[Bankett UG] 
miteinander verbindet. 


4. Wählen Sie in der Liste Anweisungstyp den Eintrag Verbinden. 


5. Füllen Sie die Felder der Anweisungsdetails wie folgt aus: 


 Von Knoten:  8[Fahrspur UG] 


 Zu Knoten:  9[Bankett UG] 


 Materialschichten: Untergrund 


6. Klicken Sie auf die Schaltfläche Hinzufügen. 


 


Sie können nun die Anweisungen zum Definieren von Knoten und Linien auf der 
linken Seite des Achsknotens 1[CL] erstellen. In diesem Tutorium entspricht die linke 
Seite der rechten Seite, sodass Sie den Befehl Anweisungen spiegeln verwenden 
können. 


8i: Spiegeln der Anweisungen der rechten Seiten in die Vorlage 
der linken Seite 


1. Klicken Sie auf die Schaltfläche Anweisungen spiegeln  oben im Fenster 
Korridorvorlage bearbeiten. 
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Die Anweisungen werden auf die linke Vorlagenseite gespiegelt (siehe Abbildung). 


 


2. Verwenden Sie den Schieberegler unter der Liste Anweisungen, um sich die 
Vorlagenänderungen in Relation zur vorhandenen Oberfläche entlang des Korridors 
anzusehen. 


Die Station wird links angezeigt. 


 
Die Vorlage ist jetzt vollständig. Sie können bei Bedarf weitere Vorlagen in den 
Korridor einfügen. In diesem Tutorium erstellen wir jedoch keine weiteren Vorlagen 
mehr. Stattdessen erfahren Sie nun, wie Sie eine vorhandene Vorlage durch 
Bearbeiten einer Anweisung ändern können. 


3. Klicken Sie im Fenster Korridorvorlage bearbeiten auf Schließen. 
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Schritt 9: Bearbeiten von Anweisungen 
In diesem Schritt bearbeiten Sie eine Anweisung der neu erstellten Korridorvorlage, 
indem Sie die linke Kante der linken Fahrspur auf Basis der als Referenzlinie 
hinzugefügten CAD-Polylinie neu definieren. Da die CAD-Polylinie unterschiedliche 
Abstände zur Achse aufweist, wird auch die linke Kante der linken Fahrspur im Abstand 
zur Achse variieren. 


1. Wählen Sie im Fenster von Trimble Business Center auf Ansicht > Projekt-
Explorer oder klicken Sie auf die Schaltfläche Projekt-Explorer  in der 
Symbolleiste. 


Der Projekt-Explorer  erscheint. 


 


2. Erweitern Sie im Projekt-Explorer den Punkt Korridor und klicken Sie mit der 
rechten Maustaste auf den Korridorvorlagenknoten 0+00.00, Template 01 und 
wählen Sie den Eintrag Bearbeiten. 


Das Fenster Korridorvorlage bearbeiten erscheint. 


 


3. Schließen Sie den Projekt-Explorer. 
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4. Klicken Sie im Fenster Korridorvorlage bearbeiten in der Liste Anweisungen 
doppelt auf die Anweisung 10[Fahrspur] oder klicken Sie mit rechts darauf und 
wählen Sie Bearbeiten. 


 


Die Eigenschaften für den Knoten 10[TL] werden im Abschnitt Anweisungsdetails 
angezeigt. 
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5. Klicken Sie auf den Auswahlpfeil auf der Schaltfläche Abstand und wählen Sie 2D-
Linie . Markieren Sie dann in der Grafikansicht den Knoten 2. (Scrollen Sie mit 
dem Mausrad, um bei Bedarf die Ansicht zu vergrößern.) 


 


Das Feld Abstand zeigt den Eintrag CAD-Polylinie. 


 


6. Klicken Sie auf Speichern. 


Die linke Kante der linken Fahrspur ist nun von der Lage der CAD-Polylinie abhängig. 
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7. Verwenden Sie den Schieberegler unter der Liste Anweisungen, um sich die 
Vorlagenänderungen in Relation zur vorhandenen Oberfläche und der CAD-Polylinie 
entlang des Korridors anzusehen. 


 


 


Schritt 10: Prüfen des größten Musterabstands 
Korridorvorlagen erzeugen eine Oberfläche, die in den Schlüsselpunkten von Grundriss 
und Aufriss der Trasse Schnitte enthält. Weitere Schnitte (Querprofile) werden in dem 
Intervall (Musterabstand) erzeugt, das in den Projekteinstellungen gewählt wurde. In 
diesem Schritt prüfen Sie, ob der Musterabstand korrekt gewählt ist. 


1. Wählen Sie Projekt > Projekteinstellungen. 
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2. Wählen Sie im Navigationsfenster des Dialogs Projekteinstellungen den Eintrag 
Berechnungen > Korridor. 


 


Sie können den größten Musterabstand verkleinern, um mehr Schnitte zu 
erzeugen; dadurch ergibt sich eine glattere Oberfläche in Kurven und Ausrundungen. 
In diesem Tutorium verwenden Sie jedoch die Vorgaben. 


3. Klicken Sie auf die Schaltfläche Abbrechen. 


Nun können Sie den Korridor exportieren. 


Schritt 11: Exportieren von Korridoren 
In diesem Schritt exportieren Sie den neu erstellten Korridor als RXL-Datei. 


1. Wählen Sie Datei > Exportieren. Klicken Sie alternativ auf die Schaltfläche 
Exportieren  in der Symbolleiste. 


2. Klicken Sie im Fenster Exportieren auf das Register Vermessung. Wählen Sie dann 
in der Liste den Eintrag RXL-Trassenexport aus Korridor. 
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3. Geben Sie im Feld Abstand links den Wert 50 ein. Geben Sie im Feld Abstand 
rechts den Wert 35 ein. 


Diese Abstände sorgen dafür, dass der gesamte Korridor in der exportierten 
Oberfläche enthalten ist. 


 


4. Klicken Sie im Bereich Dateiname auf Mehr  und wählen Sie den Pfad, in den die 
Datei exportiert werden soll. 


5. Klicken Sie auf die Schaltfläche Exportieren. 


Sie haben alle Arbeitsschritte für den Korridor ausgeführt und können das Projekt 
nun schließen. 


6. Wählen Sie Datei > Projekt schließen. 


Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 
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Über dieses Tutorium 
Die „Überhöhung“ ist die Querneigung einer Straße im Verlauf einer Kurve im Grundriss. 
Sie ermöglicht ein sicheres und komfortables Durchfahren der Kurve bei 
Entwurfsgeschwindigkeit. Mit zunehmender Geschwindigkeit und engeren 
Horizontalkurven ist eine steilere Überhöhungsrate erforderlich. 


In diesem Tutorium erstellen Sie eine Überhöhung für ein gekrümmtes Kurvenband. 
Anschließend wenden Sie die Überhöhung in Form einer Anweisung für die 
Korridorvorlage auf die Trasse an. Schließlich definieren Sie Neigungssperren für die 
Trasse, damit die Neigungsunterschiede zwischen den Segmenten (z. B. zwischen 
Fahrspur und Bankett in einer überhöhten Kurve) aus Gründen der Sicherheit und des 
Komforts bei Entwurfsgeschwindigkeit minimal bleiben. 


Hinweise: 


 Das in der Folge beschriebene Erstellen einer Überhöhung kann nur mit der Lizenz 
Survey Advanced von Trimble Business Center durchgeführt werden. Welche 
Lizenz installiert ist, können Sie unter Hilfe > Über Trimble Business Center und 
dort Lizenz einsehen. Die Liste Funktionen zeigt die lizenzierten Funktionen an. 


 Wenn Sie noch nicht mit Korridoren und Korridorvorlagenanweisungen vertraut sind, 
sollten Sie zuerst das Tutorium Arbeiten mit Korridoren absolvieren. 


 Wenn Sie während der Arbeit mit der Software Hilfe benötigen, drücken Sie einfach 
auf F1, um die Onlinehilfe aufzurufen. 


 


Schritt 1: Öffnen von Projekten 
In diesem Tutorium verwenden Sie die Projektdatei Working with Superelevations.vce. 
Dieses Projekt enthält eine Oberfläche, ein horizontales und vertikales Kurvenband und 
einen Korridor. 


1. Wählen Sie in der Menüleiste von Trimble Business Center den Eintrag Datei > 
Projekt öffnen. Klicken Sie alternativ auf die Schaltfläche Projekt öffnen  in der 
Symbolleiste. 


2. Markieren Sie im Dialog Datei öffnen die Datei C:\Trimble 
Tutorials\TBC\Projects\Working with Superelevations.vce und klicken Sie auf 
Öffnen. 


Falls Sie das Tutorium nicht im gezeigten Vorgabepfad installiert haben, müssen Sie 
den Pfad entsprechend anpassen. 
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Das Projekt wird im Fenster von Trimble Business Center angezeigt. 


 


Hinweis: Diese Abbildung zeigt die Planansicht mit weißem Hintergrund. Ihr 
Hintergrund ist möglicherweise schwarz. Um die Hintergrundfarbe in Weiß zu ändern, 
wählen Sie Extras > Optionen und im Dialog Optionen den Punkt 
Hintergrundfarbe: Weiß. 


Die Projektdatei ist schreibgeschützt. Sie können alle Schritte des Tutoriums befolgen, 
ohne die Projektdatei speichern zu müssen. Wenn Sie allerdings das Tutorium 
unterbrechen müssen, können Sie es über Datei > Projekt speichern unter im Ordner 
..\Eigene Dateien\Trimble Business Center, in dem die Projektdateien üblicherweise 
abgelegt werden, zwischenspeichern. Sie können es später aus diesem Ordner laden 
und fortsetzen. 


Schritt 2: Anwenden von Überhöhungen auf 
Kurvenbänder 


Das horizontale Kurvenband in diesem Projekt enthält zwei Bogenkurven, von denen 
eine Ein- und Ausgangsklothoiden enthält. In diesem Tutorium wenden Sie eine 
Überhöhung auf die beiden Kurven an, um Neigungsänderungen (Querneigung) in der 
Kurve zu definieren. Später wenden Sie Überhöhungsanweisungen auf eine 
Korridorvorlage an. 
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Hinweis: Eine genauere Beschreibung von Überhöhung finden Sie im Thema 
„Grundlagen zu Überhöhungen“ in der Onlinehilfe. 


1. Wählen Sie Ansicht > Projekt-Explorer. 


2. Erweitern Sie im Projekt-Explorer den Knoten Kurvenbänder . Wählen Sie im 
Kontextmenü (Rechtsklick) von Trasse überhöhen den Eintrag Bearbeiten. 


Der Kurvenbandeditor erscheint im unteren Teil des Anwendungsfensters. 


 


3. Wählen Sie im Kurvenbandeditor auf der linken Seite das Register Überhöhung. 
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Blättern Sie bei Bedarf in der Registerliste zum Register Überhöhung. 


 


 


Über die Liste oben im Register können Sie jede Kurve im horizontalen Kurvenband 
auswählen, um die Überhöhungsparameter festzulegen. Für jede Kurve werden 
Anfangsstationierung und Radius angezeigt. 


Sie definieren zuerst die Überhöhungsparameter der ersten Kurve (einfacher Bogen). 


4. Wählen Sie in der Liste die erste Kurve: 12+00,00, Radius = 1000,000 .Geben Sie 
dann die folgenden Parameter ein: 


a. Geben Sie im Feld Normale Querneigung den Wert –2,00% ein. 


Dieser Wert entspricht der normalen Querneigung der Trasse in Abschnitten 
ohne Überhöhung und wird von allen überhöhten Kurven im Kurvenband als 
Bezugsgröße verwendet. Änderungen in diesem Feld wirken sich auf alle 
überhöhten Kurven aus. Wenn Sie die normale Querneigung löschen, wird die 
Überhöhung aus dem Kurvenband entfernt. 


Hinweis: Der eingegebene Wert für die normale Querneigung wird in der Ansicht 
Überhöhungsdiagramm verwendet. Er ersetzt nicht den Neigungswert in 
Anweisungen für Korridorvorlagen. 


b. Geben Sie im Feld Maximale Überhöhung den Wert 6 ein. 


Sobald Sie den Cursor in ein anderes Feld versetzen oder die Tabulatortaste 
drücken, ändert sich der Wert  6 in 6,00%. Dies ist die maximale 
Überhöhungsrate für die Kurve als prozentuale Neigung ein. 
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Die Felder im rechten Teil des Register werden anhand der maximalen 
Überhöhung von 6,00% für eine einfache Kreisbogenkurve automatisch 
ausgefüllt. Da der Kreisbogen keine Ein- und Ausgangsklothoiden aufweist, 
werden für die Überhöhungsübergänge die Bogenparameter verwendet. Das 
bedeutet, dass es keinen Übergang von der normalen Kronhöhe zur vollen 
Überhöhung und zurück gibt. Die Änderung ist abrupt. Diesen Umstand 
korrigieren Sie später. 


 


c. Geben Sie ins Feld Ausrundungslänge den Wert 100 ein. 


Dieser Wert bestimmt die Länge der Parabelkurve im Aufriss, die an jedem 
Überhöhungsanfangs- oder Endpunkt der überhöhten Kurve verwendet wird, um 
den Übergang zu glätten. Der Übergangspunkt ist der VTS (vertikaler 
Tangentenschnittpunkt) der Ausrundung. Die Ausrundungen werden im 
Überhöhungsdiagramm an den Übergangspunkten dargestellt. 


Sie können nun die Parameter für die zweite Kurve im horizontalen Kurvenband 
definieren; dort existiert ein Kreisbogen mit Eingangsklothoide und 
Ausgangsklothoide. 


5. Wählen Sie in der Liste die zweite Kurve: 34+00,00, Radius = 900,000 .Geben Sie 
dann die folgenden Parameter ein: 


a. Geben Sie im Feld Normale Querneigung den Wert –2,00% ein. 


b. Geben Sie im Feld Maximale Überhöhung den Wert 6 ein. 


c. Geben Sie ins Feld Ausrundungslänge den Wert 100 ein. 
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Die Felder im rechten Teil des Register werden anhand der maximalen 
Überhöhung von 6,00% für eine Kreisbogenkurve mit Ein- und 
Ausgangsklothoide automatisch ausgefüllt. Die Werte für Eingangsklothoide, 
Kreisbogen und Ausgangsklothoide werden benutzt, um die 
Überhöhungsübergangsstationen zu bestimmen. 


 


 Anfang des Überhöhungsübergangs legt die Station fest, an welcher der 
Übergang von der normalen Kronhöhe zur maximalen Überhöhung von 6 % 
Neigung beginnt. 


 Anfang der maximalen Überhöhung legt die Station fest, an welcher die 
maximale Überhöhung von 6 % Neigung beginnt. 


 Ende der maximalen Überhöhung legt die Station fest, an welcher die 
maximale Überhöhung von 6 % Neigung endet und der Übergang zur 
normalen Kronhöhe beginnt. 


 Ende des Überhöhungsübergangs legt die Station fest, an welcher der 
Übergang von der maximalen Überhöhung von 6 % Neigung zurück zur 
normalen Kronhöhe endet. 


Die folgende Abbildung verdeutlicht den Übergang von der normalen Kronhöhe 
zur vollen Überhöhung und zurück. 


Kommend: 


Beginnen mit normaler Kronhöhe. 


 
 


Übergang bis zu dem Punkt, an dem die äußere Spur eine Querneigung von Null 
(eben) aufweist. 
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Übergang bis zu dem Punkt, an dem die Kronhöhe nicht mehr existiert. 


  
 


Maximale Überhöhung. 


 
 


Gehend: 


Übergang zurück zu dem Punkt, an dem die Kronhöhe nicht mehr existiert. 


  
 


Übergang zurück zu dem Punkt, an dem die äußere Spur eine Querneigung von 
Null (eben) aufweist. 


  
 


Zurück auf normaler Kronhöhe. 


 
 


Betrachten Sie nun die definierte Überhöhung im Überhöhungsdiagramm. 
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6. Klicken Sie oben im Register Überhöhung auf Überhöhungsdiagramm. Klicken Sie 
dann mit der rechten Maustaste auf das Register Überhöhungsdiagram und wählen 
Sie In die vorherige Registergruppe verschieben. 


 


Das Diagramm zeigt das eigentliche Überhöhungsprofil auf einem Raster an. Die 
vertikalen Linien stehen für Stationen entlang des Kurvenbandes. Die horizontalen 
Linien geben die Neigung in Grad an. Die beiden farbigen Linien des 
Überhöhungsprofils stellen die Innen- und Außenkante der Straße dar. Das 
Diagramm wird bei Änderungen auf dem Register Überhöhung automatisch 
aktualisiert. 


Hinweis: Sie können den Plotmaßstab und die Überhöhung im Diagramm in den 
Projekteinstellungen ändern. 
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Das Diagramm zeigt, dass die zweite Kurve (2 in der folgenden Abbildung, ein 
Kreisbogen mit Ein- und Ausgangsklothoide) einen Übergang von der normalen 
Kronhöhe zur maximalen Überhöhung und zurück enthält. Die erste Kurve (1 in der 
folgenden Abbildung) enthält keine Klothoiden; daher ist kein Übergang dafür 
angegeben. Stattdessen wird in der Kurve abrupt von der normalen Kronhöhe zur 
maximalen Überhöhung gewechselt. Diesen Umstand korrigieren Sie im nächsten 
Schritt. 


 


7. Wählen Sie in der Liste auf dem Register Überhöhung die erste Kurve: 12+00,00, 
Radius = 1000,000 .Geben Sie dann die folgenden Parameter ein: 


a. Geben Sie im Feld Anfang des Überhöhungsübergangs den Wert 900 ein. 


b. Geben Sie im Feld Ende des Überhöhungsübergangs den Wert 2100 ein. 
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Die erste Kurve weist nun einen Übergang von der normalen Kronhöhe zur 
maximalen Überhöhung und zurück auf. 


 
Sie haben erfolgreich eine Überhöhung mit einem horizontalen Kurvenband verwendet. 
Nun wenden Sie Überhöhungsanweisungen auf eine Korridorvorlage an. 


Schritt 3: Hinzufügen von Überhöhungsanweisungen 
zu Korridorvorlagen 


1. Erweitern Sie im Projekt-Explorer den Knoten Korridore  und den Knoten 2 
Lane. Wählen Sie dann im Kontextmenü (Rechtsklick) von 0+000, Typisch den 
Eintrag Bearbeiten. 
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Das Fenster Korridorvorlage bearbeiten erscheint. 


 


Die Vorlage enthält neun Anweisungen zum Definieren der Materialschichten „Fertig“ 
und „Untergrund“. 


 


Die Knoten 2[EP] (1 oben) und 5[EP] (2 oben) definieren die rechte und linke 
Deckenkante in der Schicht „Fertig“; beide müssen überhöht werden. Daher müssen 
Sie eine Überhöhungsanweisung in die Liste Anweisungen direkt hinter den 
Anweisungen, mit denen die Knoten definiert werden, einfügen. Dazu verschieben 
Sie zuerst die Anweisung, mit der der Knoten 5[EP] definiert wird, direkt unter die 
Anweisung, in der der Knoten 2[EP] definiert wird. 


2. Verwenden Sie die Maus, um in der Liste Anweisungen die Anweisung, mit der der 
Knoten 5[EP] definiert wird, direkt unter die Anweisung, in der der Knoten 2[EP] 
definiert wird, zu verschieben. 
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Der Knotenname ändert sich von 5[EP] in 3[EP]. 


 


Jetzt können Sie direkt nach der Anweisung, mit der der Knoten 3[EP] definiert wird, 
eine neue Überhöhungsanweisung einfügen. 


3. So fügen Sie eine Überhöhungsanweisung für die Schicht „Fertig“ ein: 


a. Markieren Sie die Anweisung, in der der Knoten 3[EP] definiert wird, in der Liste 
Anweisungen. 


b. Klicken Sie auf die Schaltfläche Anweisung hinzufügen  oben im Fenster 
Korridorvorlage bearbeiten. 


c. Wählen Sie in der Liste Anweisungstyp den Eintrag Überhöhung. 


d. Markieren Sie in der Liste Kronknoten den Eintrag 1[Überh. Trasse]. 


e. Markieren Sie in der Liste Drehpunkt den Eintrag 1[Überh. Trasse]. 


Um diesen Knoten dreht sich die Überhöhungsneigung. Der Knoten wird der 
Liste Ausgewählte Knoten automatisch hinzugefügt. 


f. Markieren Sie in der Liste Knoten wählen den Knoten 2[EP] und klicken Sie auf 
Hinzufügen, um ihn zur Liste Ausgewählte Knoten hinzuzufügen. 


Sie können auch auf das Feld Knoten wählen klicken und in der Vorlagengrafik 
den Knoten 2[EP] auswählen. 
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a. Markieren Sie in der Liste Knoten wählen den Knoten 3[EP] und klicken Sie 
unter der Liste auf Hinzufügen. 


 
b. Klicken Sie unten im Fenster Korridorvorlage bearbeiten auf Hinzufügen. 


Die neue Überhöhungsanweisung wird in die Liste Anweisungen eingefügt. 


 


4. Mit dem Schieberegler unter der Liste Anweisungen können Sie die Vorlage entlang 
des Kurvenbandes betrachten. 
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Bei Station 9+00,00 beginnt der Übergang zur maximalen Überhöhung in der ersten 
Kurve. Die maximale Überhöhung ist bei Station 12+00,00 erreicht. 


 


Bei Station 21+00,00 kehrt die Vorlage zur normalen Kronhöhe zurück. Bei Station 
25+60,00 beginnt der Übergang zur maximalen Überhöhung in der zweiten Kurve. 
Die maximale Überhöhung der zweiten Kurve ist bei Station 34+00,00 erreicht. 


 


Die Schicht „Fertig“ der Vorlage wurde erfolgreich überhöht. Nun wenden Sie eine 
Überhöhung auf die Schicht „Untergrund“ an. 
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5. So fügen Sie eine Überhöhungsanweisung für die Schicht „Untergrund“ ein: 


a. Klicken Sie in der Liste Anweisungen doppelt auf die letzte Anweisung in der 
Liste (mit der der Knoten 10[SG-ES] definiert wird). 


b. Klicken Sie auf die Schaltfläche Anweisung hinzufügen  oben im Fenster 
Korridorvorlage bearbeiten. 


c. Wählen Sie in der Liste Anweisungstyp den Eintrag Überhöhung. 


d. Markieren Sie in der Liste Kronknoten den Eintrag 8[SG-CL]. 


e. Markieren Sie in der Liste Drehpunkt den Eintrag 8[SG-CL]. 


Der Knoten wird der Liste Ausgewählte Knoten automatisch hinzugefügt. 


f. Markieren Sie in der Liste Knoten wählen den Knoten 9[SG-ES] und klicken Sie 
auf Hinzufügen, um ihn zur Liste Ausgewählte Knoten hinzuzufügen. 


g. Markieren Sie in der Liste Knoten wählen den Knoten 10[SG-ES] und klicken 
Sie auf Hinzufügen. 


h. Markieren Sie in der Liste Ausgewählte Knoten im Kontextmenü von 1[Überh. 
Trasse] auf Löschen, um ihn aus der Liste zu entfernen. 


 


i. Klicken Sie unten im Fenster Korridorvorlage bearbeiten auf Hinzufügen. 
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Die neue Überhöhungsanweisung wird in die Liste Anweisungen eingefügt. 


 


6. Mit dem Schieberegler unter der Liste Anweisungen können Sie die Vorlage entlang 
des Kurvenbandes betrachten. 


Die überhöhte Neigung in der Schicht „Untergrund“ entspricht nun derjenigen in der 
Schicht „Fertig“. 


 
Nun können Sie Neigungssperren für die Trasse definieren, damit die 
Neigungsunterschiede zwischen Fahrspur und Bankett in überhöhten Kurven aus 
Gründen der Sicherheit und des Komforts bei Entwurfsgeschwindigkeit minimal bleiben. 
Weitere Informationen zu Neigungssperren finden Sie im Thema „Beispiele für 
Neigungssperren“ in der Onlinehilfe. 
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Schritt 4: Definieren von Neigungssperren 
In der folgenden Abbildung ist zu erkennen, dass bei maximaler Überhöhung in der 
ersten Kurve ein Neigungsunterschied von 10 % zwischen der linken Spur (Außenspur in 
der Kurve) und dem linken Bankett vorliegt. Zwischen der rechten Spur (Innenspur in der 
Kurve) und dem rechten Bankett beträgt die Neigungsdifferenz 2 %. 


 


Legende: 
1. –4 % Bankett 
2. 10 % Differenz 
3. 6 % Überhöhung linke Spur 
4. –6 % Überhöhung rechte Spur 
5. 2 % Differenz 
6. –4 % Bankett 


Beide Neigungsunterschiede sind zu extrem für die Entwurfsgeschwindigkeit. Daher 
legen Sie Höchst- und Mindestunterschiede für den Korridor fest, um die 
Neigungsunterschiede zu ändern. Sie beginnen mit dem Definieren der zulässigen 
Mindest- und Höchstwerte für Neigungsunterschiede für die rechte Spur und das rechte 
Bankett. 


1. Klicken Sie in der Liste Anweisungen doppelt auf die Anweisung, mit der der Knoten 
4[ES] definiert wird. Wählen Sie alternativ im Kontextmenü (Rechtsklick) Bearbeiten. 
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Dieser Knoten definiert das rechte Bankett. Die Eigenschaften der Anweisung 
werden im Bearbeitungsmodus angezeigt. 


 


2. Aktivieren Sie das Kontrollkästchen Neigungssperren definieren. 


 


Der Wert Größtes Delta legt den maximal zulässigen Neigungsunterschied zwischen 
der Fahrspur und dem Bankett an der Außenseite der Kurve fest. Der Wert Kleinstes 
Delta legt den kleinsten zulässigen Neigungsunterschied zwischen der Fahrspur und 
dem Bankett an der Innenseite der Kurve fest. Für diese Trasse ist die rechte Spur in 
der ersten Kurve die Innenspur, in der zweiten Kurve jedoch die Außenspur. Daher 
gilt der Wert Größtes Delta in der zweiten Kurve für die rechte Spur und das rechte 
Bankett. Der Wert Kleinstes Delta gilt in der ersten Kurve für die rechte Spur und 
das rechte Bankett. 


3. Geben Sie im Feld Größtes Delta den Wert 4% ein. Geben Sie im Feld Kleinstes 
Delta den Wert 0% ein. Klicken Sie dann auf Speichern. 


4. Mit dem Schieberegler unter der Liste Anweisungen können Sie die Vorlage entlang 
des Kurvenbandes betrachten. 
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Wenn Sie die maximale Überhöhung der ersten Kurve erreichen, beträgt der 
Unterschied zwischen der rechten Spur (innen) und dem rechten Bankett nun 0% 
(entsprechend dem spezifizierten kleinsten Delta von 0%). 


 


Wenn Sie die maximale Überhöhung der zweiten Kurve erreichen, beträgt der 
Unterschied zwischen der rechten Spur (außen) und dem rechten Bankett nun 4% 
(entsprechend dem spezifizierten größten Delta von 4%). 


 


Sie können nun die Neigungssperren für die linke Spur und das linke Bankett 
definieren. Für diese Trasse ist die linke Spur in der ersten Kurve die Außenspur, in 
der zweiten Kurve jedoch die Innenspur. 


5. Klicken Sie in der Liste Anweisungen doppelt auf die Anweisung, mit der der Knoten 
6[ES] definiert wird. Wählen Sie alternativ im Kontextmenü (Rechtsklick) Bearbeiten. 


 
6. Aktivieren Sie das Kontrollkästchen Neigungssperren definieren. 


7. Geben Sie im Feld Größtes Delta den Wert „4%“ ein. Geben Sie im Feld Kleinstes 
Delta den Wert „0%“ ein. Klicken Sie dann auf Speichern. 


8. Mit dem Schieberegler unter der Liste Anweisungen können Sie die Vorlage und 
damit die Neigungssperren entlang des Kurvenbandes betrachten. 


 


Schritt 5: Betrachten des Kurvenbandes in der 3D-
Fahrtansicht 


So simulieren Sie eine Fahrt entlang der neuen überhöhten Trasse: 
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1. Wählen Sie im Fenster Trimble Business Center den Eintrag Ansicht > 
Kurvenband > Neue 3D-Fahrtansicht. 


 


2. Mit dem Schieberegler unten auf dem Register können Sie die Trasse entlang des 
Kurvenbandes betrachten. 


 


Sie haben alle Arbeitsschritte für Überhöhungen ausgeführt und können das Projekt 
nun schließen. 


3. Wählen Sie Datei > Projekt schließen. 
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Der Dialog Änderungen speichern erscheint. Falls Sie das Projekt unter einem 
anderen Namen oder in einem anderen Pfad gespeichert haben, können Sie auf Ja 
klicken. Klicken Sie ansonsten auf Nein. 
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About this tutorial 
In this tutorial, you will import a survey project that includes scanned data and photo 
images captured with a Trimble VX Spatial Station while surveying a material pile. Then 
you will create a surface and calculate the volume of the pile. 


Notes: 


 To add surface boundaries as described later in this tutorial, you must be running 
Trimble Business Center software with the Survey Advanced product license. To 
verify the product license for your installation, select Help > About Trimble 
Business Center and click the License button. Licensed features are displayed in 
the Features list. 


 If you need additional help at any time you are using the software, press F1 to display 
the online help. 


 


Step 1. Open the project 
For this tutorial, you will use the project file Working with Scanned Data.vce. This file 
contains a surface that you will view later in the tutorial. Otherwise, no other data has 
been imported into the project. 


1. On the Trimble Business Center menu bar, select File > Open Project. Or, click 
the Open Project icon  on the toolbar. 


2. In the Open File dialog, browse to C:\Trimble Tutorials\TBC\Projects\Working 
with Scanned Data.vce and click Open. 


If you installed the tutorial to a location other than the default location shown here, 
browse to that location. 


The project opens in the Trimble Business Center window. 


Note: This tutorial shows the Plan View with a black background. Your background 
may be white. If you want to change it to black, select Tools > Options and select 
Background color: Black in the Options dialog. 


The project file is read-only. You can perform the tutorial steps without saving the project 
file. However, if you are interrupted while performing the tutorial, you can save it by 
selecting File > Save Project As and saving it to ..\My Documents\Trimble Business 
Center, which is the typical location for storing project files on your computer. Then, you 
can re-open the project to continue the tutorial at a later time. 


You are now ready to import survey data into your project. 


Step 2. Import survey data 
In this step, you will import a JXL (.jxl) file into your project. During the import process, 
the following related files are imported along with the JXL file: 
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 Four Trimble Scan Files (TSF) containing the scanned information from the Trimble 
VX Spatial Station 


 Numerous photo images captured with the Trimble VX during the survey 


 A Feature Definition (.fxl) file containing definitions used to record and process 
feature codes 


1. Select File > Import. Or, click the Import icon  on the toolbar. 


The Import pane opens in the right side of the Trimble Business Center window. 


2. In the Import pane, click the Browse button . 


3. Browse to C:\Trimble Tutorials\TBC\Data\Working with Scanned Data and click 
OK. 


The Working with Scanned Data folder contains the JXL job file and related files, all 
of which display in the Select File(s) list in the Import pane. 


 


4. In the Select File(s) list, select argpile144.jxl and click the Import button. 


The content of the Working with Scanned Data folder is imported into your project. 
Survey data is displayed in the Plan View. 


5. Click in the Plan View and use your mouse wheel to zoom in. Press the mouse 
wheel and move the mouse to center the points as shown here. 
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Photo images (reference images) taken during the job using the Trimble VX are 
represented by the orange lines in the Plan View. (If you zoom in, you will see these 
are actually wireframes that are used as placeholders for the images.) Scanned data 
displays as "point clouds." 


 


 


Step 3. View referenced photo images 
The imported job includes numerous referenced photo images that can be viewed on the 
Image View tab. Note that the images are located at a default pseudo-distance from the 
instrument. This is because the images themselves do not have distance information. 


You will start by verifying the default image view distance defined for your project. 


1. Select Project > Project Settings. Or, click the Project Settings icon  on the 
toolbar. 
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2. In the navigation (left) pane in the Project Settings dialog, select View > Image 
View. 


 


In some instances, modifying this distance can help to correct the alignment of 
objects between multiple images. When the objects in the images are at a distance 
greater than or less than this default distance, changing the Image View distance to 
a more realistic distance will help with the object alignment. 


However, for this tutorial you will not change the default distance. 


3. Click Cancel to close the Project Settings dialog. 


Next you will change the highlight color to make highlighted lines and point labels 
more visible in the various graphic views.  


4. To change the highlight color, do the following: 


a. Select Tools > Options. 


b. In the Options dialog, click the Browse button  for Highlight color. 


c. In the Color dialog, select bright yellow and click OK. 


 


d. In the Options dialog, click OK. 


Note: Settings in the Options dialog are not specific to a single project. They are 
kept until you change them, regardless of the project you open. If you do not want to 
keep yellow as your highlight color for other projects, you can change it at any time. 


The Options dialog includes a Cloud point size control that allows you to specify 
the pixel size of each point contained in a point cloud displayed in a graphic view. For 
this tutorial, you will leave it at the default size of 2 pixels. 
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You can click the Advanced button to display the Advanced Graphics Options 
dialog. This dialog provides options for enhancing your graphics display and 
performance when you are exploring rich data sets in the various graphic views. For 
more information on this dialog, open it and press F1. 


You are now ready to view photo images. You will start by selecting a station from 
which photos were taken. 


5. In the Plan View, do the following: 


a. Click point 102 and select Station: 102 in the context menu. 


Each station from which photos were taken is identified by a pink camera symbol 
in the Plan View. 


 


b. Right-click in the Plan View and select New Image View. 


The Image View displays showing the array of photo images taken from Station 102 
interlaced in a panoramic view.  


Notes: Depending on your computer configuration and available memory, it may take 
several moments to display the image. 
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The orange wireframes displayed on the Image View represent photo image arrays 
taken from other station setups. 


To view an array of photo images taken from a different station, you can either select 
a station (represented by a pink camera icon) or select one of the wireframes in the 
Image View. . 


6. Click one of the wireframes in the array on the right side of the photo images from 
station 102, and select Referenced Image: IMG00010.JPG in the context menu. Then 
right-click and select New Image View in the context menu. 


 


The newly selected photo image, along with other photo images in the array, displays 
centered on the Image View, outlined by a yellow box.  
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Note that the name of the station from which the array of photo images was taken is 
displayed in the lower left corner of the Image View. 


 


Note: Viewing a large number of images can require a lot of computer memory. If 
there is inadequate memory available to display all of the images, some images will 
display only as a green wireframe on the Image View. In this case, you should close 
and reopen the Image View. 


Next you will try a different method of selecting an image to view. 


7. Click on the Image View somewhere other than on an image or wireframe so that no 
image is selected. Then select View > New Image View in the menu bar. 


The Select Image dialog displays allowing you to select any station or image in the 
project to view the image(s) on the Image View tab.  


 


8. Click Cancel to close the Select Image dialog. 


Next, you will use the View Filter Manager to change how your data is displayed. 
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Step 4. Filter the view 
1. Select View > View Filter Manager. 


 


2. Deselect the following options in the Raw Data list to see how it affects your image. 


 Referenced Frame 


 Scan Point 


 Total Station 


 


Only surveyed points are displayed. 
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3. On the Point tab in the bottom of the View Filter Manager pane, deselect the Show 
point label option. 


The surveyed points circled in the following figure are on the backside and the top of 
the material pile. Because the images do not have depth, all surveyed points in the 
project are visible in the Image View. 


 


4. Reselect the Scan Point option in the Raw Data list in the View Filter Manager 
pane. Then try viewing the data using other views: 


 Select the Plan View and use your mouse wheel to zoom out as shown here. 


 


 Select View > New 3D View and experiment with changing the perspective. 


 Use the mouse wheel to zoom in or out. 


 Press the Ctrl key and use the mouse wheel to rotate the view around the X 
axis. 


 Press the Shift key and use the mouse wheel to rotate the view around the Z 
axis.  
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 Press the Ctrl + Shift key and use the mouse wheel to exaggerate 
differences between elevations. 


 Press the Ctrl key and use the mouse wheel along with moving the mouse to 
rotate the view freely in any direction. 


 


5. Reselect the Show point labels option on the Point tab in the View Filter Manager 
pane. 


In the next two steps, you will create a surface so that you can calculate the volume of 
the materials pile. 


Step 5. Create a boundary for a surface 
The scanned points around the perimeter of the materials pile are coded with appropriate 
feature codes to create four separate feature linestrings. In this step, you will first process 
the feature codes to create the linestrings. Then you will join the four linestrings into a 
single linestring to create a boundary for the material pile. Later in the tutorial, you will 
create a surface based on this boundary, and calculate the volume of the material pile. 


For this project, the feature definitions required to process the feature codes were 
imported automatically when you imported argpile144.jxl. If they had not been, you would 
need to import a Feature Definition (.fxl) file prior to processing. 


Note: For more information on working with feature codes, see the tutorial Processing 
Feature Codes. 
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1. To make it easier to see the feature linestring you are going to create, in the View 
Filter Manager, deselect the Scan Point option in the Raw Data list. Then select the 
Plan View tab. 


 


2. Process the feature codes as follows: 


a. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 


b. In the Process Feature Codes pane, select the checkbox for argpile144.jxl and 
click the Process Source(s) button. 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. Click No. 
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A single line appears to connect all of the points around the perimeter of the material 
pile in the Plan View. 
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Actually, based on the feature codes assigned to the surveyed points, four feature 
linestrings were created: a longer linestring on each side of the pile in the Plan View, 
and a shorter linestring at the top and the bottom. In the following image, the two 
longer linestrings are selected (yellow). the two shorter linestrings are not selected 
(green) and are circled in red. 


 


3. To combine the four separate linestrings into a single linestring for the surface 
boundary, do the following: 


a. Select Lines > Join Lines in the menu bar. 


The Join Lines pane displays. 


 


b. Select the All selected lines option. 
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c. Click in the Lines to join field. 


d. While holding the Shift key, click each of the four linestrings in the Plan View. 


Each linestring turns yellow (highlighted) as you select it. 


e. In the Join Lines pane, click the Join button. 


The four separate linestrings are merged into a single linestring. 


4. In the View Filter Manager pane, select the Scan Point option in the Raw Data list. 


 


You are now ready to create a surface based on the new linestring boundary. 


Step 6. Create a surface 
1. Select Surface > Create Surface. 


The Create Surface pane displays. 
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2. In the Name field, enter MaterialPile. 


3. In the Surface classification drop-down list, select Stockpile. 


4. Click in the Members to form surface field. Then, in Plan View, draw a box around 
the newly created green Boundary line. 


 


5. Click OK. 
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The new MaterialPile surface is displayed in the Plan View. 


 


6. Select Surface > Add/Remove Surface Boundaries. 


The Add/Remove Surface Boundaries pane displays. 
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7. Click in the Boundaries to add or remove field. Then, in the Plan View, select the 
line created around the stockpile (Linestring: ToeDitch). 


 


8. In the Add/Remove Surface Boundaries pane, click the Add button. 


The surface is trimmed to the boundary.  


 


9. In the Add/Remove Surface Boundaries pane, click the Close button. 


10. Select the 3D View tab and view the edge of the material pile as shown in the 
following figure. 


 Use the mouse wheel to zoom in.  


 Press the Ctrl key and use the mouse wheel to rotate the view on the X axis.  


 Press the Shift key and use the mouse wheel to rotate the view on the Z axis. 
(Optionally, press the Alt key and click a location in the view  to select a new 
rotation point.)  


 Select View > 3D View Settings to display a pane that allows you to perform 
these same actions using interface controls. 
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Note: Your view does not have to match this one, as long as you can see the 
irregular points along the surface boundary as shown here. 


 


You can see variations in the surface around the perimeter of the surface (circled in 
green below). Most of these are the result of scan points being created based on 
measurements for weeds growing at the base of the pile. 


 


To ensure that your volume calculation is correct, you will need to remove these points 
since they do not represent the surface of the pile itself. 


Step 7. Remove unwanted scan points from the 
surface 


1. Click the MaterialPile surface on the 3D View to select it. Then right-click and select 
Add/Remove Surface Members. 
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The Add/Remove Surface Members pane displays. 


 


2. In the 3D View, draw a box around some of the points you want to remove from the 
surface. 


The number of selected points is displayed in the Members to add or remove field. 


 


3. Click the Remove button to remove the selected points. 
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The change is reflected in the 3D View. 


 


Typically you would repeat this procedure until you had removed all of the unwanted 
points. But for this tutorial, you are going to switch to a surface that was included in 
the project for which all unwanted points have already been reviewed. 


4. In the Add/Remove Surface Members pane, click Close. 


5. In the View Filter Manager, deselect MaterialPile in the Surface section of the list, 
and select MaterialPileDone. 
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The MaterialPileDone surface displays in the 3D View. Note that the surface no 
longer includes the unwanted points. 


 


You are now ready to calculate the volume of the material pile. 


Step 8. Calculate the volume of the material pile 
1. Select Reports > Earthwork Report. 


The Earthwork Report pane displays. 


 


2. Select the Stockpile/Depression option. 


3. In the Surface drop-down list, select MaterialPileDone. 


4. Click in the Boundary box, then select the Linestring: ToeDitch in the 3D View. 
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If necessary, zoom in to better see the linestring. 


 


5. In the Volume Breakdown section of the Earthwork Report pane, select the 
Volume totals only option. 


6. Click OK. 


The Earthwork Report opens in a browser window showing the volume calculation in 
the "Stockpile Volume Analysis" section. 


You are done calculating the volume of the materials pile. 


7. In the Trimble Business Center window, select File > Close Project. 


The Save Changes dialog displays. If you saved the project to a new location or with 
a new name, you can click Yes. Otherwise, click No. 


The next section explains how to use the Create Surface Edge Breakline command. 
Because the Working with Scanned Data.vce project file used for this tutorial does not 
include appropriate data to demonstrate this command, the section is explanatory only 
and does not include hands-on procedural instructions. 
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Note on using the Create Surface Edge Breakline 
command 


The Create Surface command sometimes adds triangle on the boundary where they are 
not needed, as shown here: 


 


Using the Trim Surface Edge command, you can remove these triangles. 
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However, subsequent editing of the surface can cause the triangles to be recalculated. 
To prevent the triangles from being recalculated, after trimming a surface you can use the 
Create Surface Edge Breakline command to draw a breakline around the existing 
surface parameter. 


 


 





		About this tutorial

		Step 1. Open the project

		Step 2. Import survey data

		Step 3. View referenced photo images

		Step 4. Filter the view

		Step 5. Create a boundary for a surface

		Step 6. Create a surface

		Step 7. Remove unwanted scan points from the surface

		Step 8. Calculate the volume of the material pile

		Note on using the Create Surface Edge Breakline command






 


  


 


Trimble Business Center Version 2.50 Tutorials 
May, 2011 


© 2011 by Trimble Navigation Limited. All rights reserved. 


 


What's new in this release 
This release of the Trimble Business Center Tutorials includes the following updates, 
which correspond to feature updates in Trimble Business Center version 2.50: 


 The Working with Scanned Data tutorial has been updated to cover newly 
enhanced image management and viewing capabilities. It also explains how to create 
a surface border using line features. (English only.) 


 The Processing Feature Codes tutorial has been rewritten to cover major 
enhancements to this feature, including creating linestrings from feature lines and 
viewing image attributes. (English only.) 


At the time of release, these two revised tutorials are in English only. Translated versions 
should be available soon in the following languages: 


 Chinese 


 French 


 German 


 Portuguese 


 Spanish 


Be sure to periodically select Help > Check for Updates in Trimble Business Center. 
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About this tutorial 
In this tutorial, you will process and edit feature codes that have been imported into your 
project. Then you will view feature data in the various project views, and export the 
features as a CAD drawing. 


Note: If you need additional help at any time you are using the software, press F1 to 
display the online help. 


Understanding Feature Code Processing 
When a surveyor observes a feature in the field, he can make a record of it that includes 
the type of feature (for example, a tree), along with its location and any associated 
attributes (for example, the height of the tree and a photo). He does this by selecting from 
a library of predefined feature codes imported from a Feature Definition (.fxl) file, and 
supplying attribute values as required. The feature codes, along with any associated 
photos and attribute values, can then be imported into a Trimble Business Center project 
and processed using the same feature definitions.  


After feature codes have been processed, the software can display symbols and line 
work that represent the real world objects. Features can then be exported to other 
systems (for example, CAD or GIS) as necessary. 


There are two basic types of features: 


 Point feature - A point feature is used to identify a single feature, such as tree or 
utility pole. Each point feature is assigned to a point, which specifies its location. After 
a point feature code is processed in Trimble Business Center, the resulting feature is 
typically represented by a specific symbol displayed on top of the point in the various 
graphic views. You can view and edit attribute values assigned to a point feature by 
opening the Properties pane for the point to which it is assigned. 


 Line feature - A line feature is used to identify a line, such as a fence or curb. When 
points with line feature codes are processed in Trimble Business Center, a linestring 
with feature data is created. The feature linestring can be easily edited using the Edit 
Linestring command. If offset lines are specified for the line feature, additional 
linestrings are created. The line style used for the linestring is determined by the 
feature definition used to define the line feature. You can view and edit attribute 
values assigned to a linestring feature by opening the Properties pane for the 
linestring. 


If a point or line feature includes a photo or other media file attribute, a Media Folder 
icon  is displayed with the point or linestring. You can view a media file by opening the 
appropriate Media Folder. 
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Step 1. Open the project 
For this tutorial, you will use the project file Processing Feature Codes.vce. The project 
includes data from a Cadastral survey of a city bus terminal. Integrated surveying 
methods were used to collect the field data.  


1. On the Trimble Business Center menu bar, select File > Open Project. Or, click 
the Open Project icon  on the toolbar. 


2. In the Open File dialog, browse to C:\Trimble Tutorials\TBC\Projects\Processing 
Feature Codes.vce and click Open. 


If you installed the tutorial to a location other than the default location shown here, 
browse to that location. 


The project opens in the Trimble Business Center window. 


 


Note: This figure shows the Plan View with a white background. Your background 
may be black. If you want to change it to white, select Tools > Options and select 
Background color: White in the Options dialog. 
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The project file is read-only. You can perform the tutorial steps without saving the project 
file. However, if you are interrupted while performing the tutorial, you can save it by 
selecting File > Save Project As and saving it to ..\My Documents\Trimble Business 
Center, which is the typical location for storing project files on your computer. Then, you 
can re-open the project to continue the tutorial at a later time. 


Step 2. Import the Feature Definition (.fxl) file 
Before you can process the feature codes imported into your project, you must import the 
same Feature Definition (.fxl) file that was used to assign codes in the field. There are 
three ways of doing this: 


 Use the Feature Code Processing section of the Project Settings dialog to import 
the Feature Definition (.fxl) file.  


 Use the Import pane to import the Feature Definition (.fxl) file. After import, the 
imported file is displayed in the Feature Code Processing section of the Project 
Settings dialog. 


 When you import a Job (.job) or JobXML (.jxl) file that specifies a Feature Definition 
(.fxl) file that is included in the same folder, the Feature Definition (.fxl) file is 
automatically imported into your project as well. After import, the imported file is 
displayed in the Feature Code Processing section of the Project Settings dialog. 


In this step, you will import the Feature Definition (.fxl) file created for this tutorial using 
the Project Settings dialog. 


1. Select Project > Project Settings. 


2. In the navigation (left) pane in the Project Settings dialog, select Feature Code 
Processing. 


 


3. Click the Browse button  located to the right of the Feature definition file field. 


4. In the Open  dialog, browse to C:\Trimble 
Tutorials\TBC\Data\GlobalFeaturesTutorial.fxl  and click Open. 


5. In the Project Settings dialog, click OK to close the Project Settings dialog.  


The feature definitions contained in GlobalFeaturesTutorial.fxl are imported into your 
project's Feature Definition Library to be used for feature processing. 
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However, before processing, you will take a look at the unprocessed feature codes in 
your project. 


Step 3. View unprocessed feature codes 
Before you process the feature codes in your project, you can view the codes and their 
assigned values, and make changes if necessary. 


1. Select View > Project Explorer. Or, click the Project Explorer icon  on the 
toolbar. 


The Project Explorer pane displays. 


2. In the Project Explorer pane, click the plus symbol next to the Points node. Then 
double-click point 700. 


 


The Properties pane displays on the right side of the window showing properties for 
point 700. The feature code assigned to the point displays in the Point Information 
section. 
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3. Click  in the Feature code field to view more information about the feature code in 
the Feature Code Editor dialog. 


 
This dialog allows you to remove a feature code, select a different feature code, add 
a feature code, and/or change attribute values. Note that the feature codes are 
defined in the GlobalFeaturesTutorial.fxl file.  


4. To view the photo assigned to point 700, select the photo attribute row and click the 
View File icon . 


The photo displays in your default photo viewing software. 
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5. When you are done viewing the Feature Code Editor, click Cancel to close the 
dialog. 


You are now ready to process the feature codes in your project. 


Step 4. Process feature codes 
You must process features codes to display their associated features correctly in graphic 
views and to export feature data. 


1. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 


2. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl and click 
the Process Source(s) button. 


 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. 


3. In the Feature Codes Processing dialog, click Yes. 


The Feature Code Processing Report displays on a new tab in the Trimble 
Business Center window. 


4. Scroll to the "Unknown Feature Codes" section. 


Note that there are four points whose feature codes are unknown. This means that 
there is no corresponding feature code contained in the project's Feature Definition 
Library to process the codes. In this case, the codes were incorrectly entered in the 
field.  


Next, you will fix the unknown feature codes before reprocessing. 


Step 5. Change feature codes 
In this procedure, you will assign the correct feature code to each of the four points listed 
in the "Unknown Feature Codes" section of the Feature Code Processing Report. But, 
because codes are read-only after features have been processed in your project, you 
must remove the processing results before you can make changes to the codes.  


1. To remove feature processing results: 


a. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 
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b. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl, and 
click the Remove Processing button. 


 


2. In the "Unknown Feature Codes" section of the Feature Code Processing Report, 
click point 727. 


The properties for point 727 are displayed in the Properties pane. 


 


The yellow icon  at the right in the Feature code field indicates the point has an 
unknown feature code. You can enter a new code directly in the field if you know it 
and you do not need to specify any attributes. Otherwise, you can click the  button 
to open the Feature Code Editor dialog to make the changes. For this tutorial, you 
will use both methods. 


3. Click the  button in the Feature code field. 
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The Feature Code Editor dialog displays. 


 


4. In the Feature code field, select rd and press the Delete key to remove the code. 


5. In the GlobalFeaturesTutorial.fxl list, select RB (RoadBarrier) and click the Add 
Code button. 


The code is added to the Feature code field. 


 


6. Click OK. 


The newly assigned code displays in the Feature code field in the Properties pane 
for point 727. 


 


7. Change codes for the other points displayed in the "Unknown Feature Codes" section 
of the Feature Code Processing Report. Just click each point in the report to display 
its properties in the Properties pane. 
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a. For point 728, change rd end to RB END. 


For this change, click the  button to open the Feature Code Editor dialog. 
Delete rd end from the Feature code field. Then select RB (RoadBarrier) in the 
GlobalFeaturesTutorial.fxl list and click the Add Code button. The code RB 
represents a line feature and should include the END (EndLine) line control code. 
Click the Category filter icon  and select Line Control Code to display only 
line control codes in the list. 


 


Select END in the list, and click the Add Code button.  


 


Then click OK to see the change in the Properties pane for point 728. 


 


b. For point 780, change cb 1x2m to CBI 1x2m. 


For this edit, type the change directly in the Feature code field. Note that the 
italicized text 1x2m is simply a free-form description for the code preceding it. 


 


c. For point 781, change cb inv to CBI INV. 
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Again, type the change directly in the Feature code field. 


 


You are now ready to reprocess the feature codes with the changes you made. 


Step 6. Reprocess feature codes 
1. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 


icon  on the toolbar. 


2. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl and click 
the Process Source(s) button. 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. 


3. In the Feature Codes Processing dialog, click Yes. 


A new Feature Code Processing Report displays on a new tab in the Trimble 
Business Center window. Note that there are no longer any unknown feature codes 
listed in the report. 


You can now view the processed features. 
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Step 7. View processed features 
1. Select the Plan View tab and use your mouse wheel to zoom in to view the 


processed feature data, as shown below.  


 


To better view the features, you can choose to hide unnecessary data in the Plan 
View. 


2. Select View > View Filter Manager. 


The View Filter Manger pane displays. 


 


3. In the Raw Data list: 


 Deselect RTK Vector. 


 Deselect Total Station. 
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Point feature symbols and feature linestrings are more clearly visible in the Plan 
View. 


 


To view information about a feature, including any attribute values, you can select the 
point or linestring to which the feature is assigned.  


4. In the Plan View, click the red symbol on point 700 and select Point: 700 in the 
context menu. 


The Properties pane for point 700 displays. In the lower portion of the pane, the 
Feature section displays the processed feature name and attribute values assigned 
to the point feature. 


 


You can select a different feature or change any attribute values using these fields. If 
you select a different feature for the point and then reprocess the feature codes in 
your project, the new feature you assigned to the point is kept with the point, while 
the original feature code is used to create a "secondary" feature for the point, which 
you can select in the Plan View. 


Although you can select a different feature for a point, you cannot edit the point's 
feature code after you have processed feature codes in your project. If you needed to 
change the code, you would first have to remove the feature processing results as 
described earlier in this tutorial. 
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If a feature includes a media attribute, such as a photo, a Media Folder icon  is 
displayed next to the point, as shown here.  


 


Note: A Media Folder is attached to any point or line to which a media file is 
assigned, whether it was assigned to the point as a feature attribute or assigned 
some other way. If a media file (for example, a photo) is assigned to a point as a 
feature attribute and additional media files are assigned to the point as well, you can 
select to use one of the other media files as the feature attribute by selecting it in the 
media (for example, Photo) drop-down list in the Feature section of the Properties 
pane. 


5. In the Plan View, click the Media Folder icon for point 700 and, if necessary, select 
Media Folder: 700 in the context menu. 


The Properties pane for the Media Folder is displayed showing the media file 
assigned to the point and information associated with it. You can click the View 
button  located to the right of the media file path to view the image in your default 
photo viewing software. 


6. In the Plan View, click the line running through point 700 and, if necessary, select 
Linestring: GutterLeft in the context menu. 


This is a linestring created from line feature codes during processing. The Properties 
pane for the linestring displays showing the feature name and any feature attributes.  


You can also view the features in your project in 3D. But before you do, you will apply 
additional filters to your view to make the features easier to see. 


7. In the View Filter Manger pane: 


 In the Raw Data list, deselect Media Folder. 


 In the Layers list, deselect Points.  


 On the Point tab, deselect Show point labels. 
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 On the Point tab, select Show feature symbol only. 


 


8. Select View > New 3D View. Or, click the New 3D View icon  on the toolbar. Then 
use your mouse wheel to zoom in as shown here. 


 


9. Select View > 3D View Settings. 


The 3D View Settings pane displays. You can use the controls in this pane to 
change the 3D view of the features. 


a. In the Vertical angle field, enter 54°00'00". 
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b. In the Azimuth field, enter 25°00'00". 


 
Note that by setting the Vertical Exaggeration factor to approximately 5 (experiment 
by sliding the control right and left), you can spot the elevation bust on a curb. 


 


10. To view the feature data in Google Earth, do the following: 


a. Select View > Google Earth. 


b. In the Google Earth pane, click the Options button and select Select All. 


 


c. Click the Apply button. 
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Points, feature lines, and camera icons are displayed in Google Earth. You can click 
any camera icon to display the associated image. 


 


Next, you will export the processed feature data as a CAD drawing file. 


Step 8. Export as a CAD drawing 


1. Select File > Export. Or, click the Export icon  in the toolbar. 


2. In the Export pane, select the CAD tab. 


 


3. On the CAD tab, select DWG exporter in the list at the top of the tab. 


4. In the Data section, click the Options button and select Select All. 


5. Click the Export button to create the CAD drawing (.dwg) file and save it to your 
project folder. 
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You are done working with feature codes. 


6. Select File > Close Project. 


The Save Changes dialog displays. If you saved the project to a new location or with 
a new name, you can click Yes. Otherwise, click No. 
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